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1 Introduction
The Event Capture System (ECS) Graphical User Interface (GUI) User Guide provides 
instructions for using the Event Capture options within the GUI setting. The target audience for 
this manual includes the users of the Event Capture package, Tier 2 VistA Support Application 
Coordinators (ACs), and other software users.
The GUI provides a consistent, event-driven, Windows® style user interface for Event Capture.
The Event Capture software provides a mechanism to track and account for procedures and 
delivered services that other Veterans Health Information Systems and Technology Architecture 
(VistA) packages do not handle. The procedures and services tracked through Event Capture are 
associated with the following:

· The patient to whom they were delivered
· The provider requesting the service or procedure
· The Decision Support System (DSS) Unit responsible for delivering the service 

DSS Units typically represent the smallest identifiable work unit in a clinical service at a medical 
center. Veterans Affairs Medical Centers (VAMCs) define the DSS Units. A DSS Unit can 
represent any of the following:

· An entire service
· A section of a service
· A small section within a section
· A medical equipment item used in patient procedures 

The user must define the following items for every DSS Unit:
· Service: The service associated with the DSS Unit.
· Cost Center: The fiscal identifier for the service using the DSS Unit.

Cost Centers are defined in detail in Volume XIII — Cost Accounting of the Financial 
Policy Volumes on the VA’s Office of Financial Policy web site.

· Medical Specialty: The specialty section associated with the DSS Unit. 

1.1 Purpose
The ECS GUI User Guide is intended for use as an instructional guide for using the Event 
Capture software. The user can use this manual in conjunction with the Event Capture GUI 
online help option.
Screen displays may vary among different sites, and the data may not appear on the monitor 
exactly as shown in this manual. Although ECS screens are subject to modification, the major 
menu options as they appear in this manual are fixed and are not subject to modification (except 
by the package developer).
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1.2 Document Orientation
The following sub-paragraphs provide general information about how to use this document.

1.2.1 Organization of the Guide 
This document is organized into the following major sections:
Introduction — This section provides a brief description of the purpose of the guide and an 
orientation into the document’s structure and use.
System Summary — This section provides a general description of the system written in non-
technical terminology, the purpose for which the system is intended, the system configuration, 
data flows, user access and continuity of operations.
Getting Started — This section provides a general walkthrough of the system from initiation 
through exit. The logical arrangement of the information enables functional personnel to 
understand the sequence and flow of the system.
Using the Software —This section serves as reference to the user, covering vital aspects of this 
tool.

· Data Entry — ECS is programmed to allow the users to enter records and edit specific 
fields.

· Spreadsheet — ECS allows the uploading of data through spreadsheets. There are two 
types of spreadsheets: Regular Spreadsheets and State Veterans Home Spreadsheets. 
Information for both types is included in this guide.

· Reports — ECS Reports are designed according to Managerial Cost Accounting Office 
(MCAO) specifications. Users have the option of previewing the report, exporting the 
report into an Excel spreadsheet, or printing a hardcopy. Some reports are only accessible 
to users with the manager security key (ECMGR).

· Management Menu — This option accesses the menus needed for management of the 
Event Capture software. It includes, but is not limited to, allocation of DSS Units, 
assignment of users to DSS units, addition of local procedures and categories, and the 
creation of Event Code Screens.

Troubleshooting — This section provides general troubleshooting advice on issues encountered 
by users.
Appendix — The following appendices are included in this guide:

· Acronyms and Abbreviations — This section provides the user with a list of 
abbreviations and acronyms used throughout the document.

· Glossary — This section provides the user with definitions of terms used throughout the 
document.

· ECS Package Administrative Messages — This section provides the user with 
examples of relevant ECS notifications.

· Index — This section provides the user with an Index of major topics of interest.
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1.2.2 Assumptions 
This guide was written with the following assumed experience/skills of the audience:

· User has basic knowledge of the operating system (such as the use of commands, menu 
options, and navigation tools).

· User has been provided the appropriate active roles, menus, and security keys required 
for ECS.

· User is using ECS to perform his/her job.
· User has validated access to ECS.
· User has completed any prerequisite training. 

1.2.3 Disclaimers 
The following disclaimers apply to all Department of Veterans Affairs (VA) user documentation.

1.2.3.1 Software Disclaimer 
This software was developed at the VA by employees of the Federal Government in the course 
of their official duties. Pursuant to title 17 Section 105 of the United States Code, this software is 
not subject to copyright protection and is in the public domain. VA assumes no responsibility 
whatsoever for its use by other parties, and makes no guarantees, expressed or implied, about its 
quality, reliability, or any other characteristic. We would appreciate acknowledgement if the 
software is used. This software can be redistributed and/or modified freely provided that any 
derivative works bear some notice that they are derived from it, and any modified versions bear 
some notice that they have been modified.

1.2.3.2 Documentation Disclaimer 
The appearance of external hyperlink references in this guide does not constitute endorsement by 
the VA of this website or the information, products, or services contained therein. The VA does 
not exercise any editorial control over the information you may find at these locations. Such 
links are provided and are consistent with the stated purpose of the VA.

1.2.4 Documentation Conventions 
To avoid displaying sensitive information regarding patients and staff, the examples in this guide 
contain pseudonyms or scrambled data instead of real names. Patients and staff will be referred 
to as “ECPATIENT, ONE”, “AAECPROVIDER, ONE”, or “USER, ONE.” Scrambled data are 
a series of random letters that replace a real name (e.g., “AAADY, JWHTRE”). Likewise, real 
social security numbers (SSNs), real addresses, and other personal identifiers are not used.

Note

· Many examples of previews or exported reports in this manual will only include a 
portion of the output produced for the purpose of saving space and maintaining 
clarity.

· Internal document links and VDL links in this manual are displayed in blue type. 
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1.2.5 References and Resources 
The documentation for Event Capture v2.0 includes the following:

· Event Capture Deployment, Installation, Back-out and Rollback Guide (DIBRG)
· Event Capture Patch Description (PD)
· Event Capture Technical Manual (TM)

These documents can be found on the VA Software Document Library (VDL) website.
Patch information and documentation is also available online at the MCA Learning Community 
for Event Capture website.

1.3 National Service Desk and Organizational Contacts
The three tiers of support documented herein are intended to restore normal service operation as 
quickly as possible and minimize the adverse impact on business operations, ensuring that the 
best possible levels of service quality and availability are maintained.
Table 1 lists organizational contacts needed by site users for troubleshooting purposes. Support 
contacts are listed by name of service responsible to fix the problem, description of the incident 
escalation, associated tier level, and contact information (email and phone number).

Table 1: Tier Support Contact Information

Name Role Org Contact Info
Local ECS 
Package 
Manager

Tier 0 
Support

Veterans 
Health 
Administration 
(VHA)

ECS Package Manager/Site Dependent
The MCAO Phone List can be found on the VA’s 
MCAO online contact page. 

Local 
Managerial 
Cost 
Accounting 
(MCA) VISN 
Coordinator

Tier 0 
Support

VHA Site Dependent
The MCAO Phone List can be found on the VA’s 
MCAO online contact page.

OIT National 
Service Desk

Tier 1 
Support

OIT National Service Desk
Incident Management Automated Notification 
Reporting (ANR) Tool

https://www.va.gov/vdl/
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2 System Summary
The Event Capture System (ECS) is a VistA Class I workload reporting system supporting 
operations of the VA MCAO. There are several VHA national programs mandating utilization of 
ECS in place of, or to augment, other workload capture information systems. For example, ECS 
is leveraged when programs cannot report workload in the form of Current Procedural 
Terminology (CPT) codes. Other times, ECS allows for more precise workload capture and 
reporting than otherwise possible through another VistA system.
Event Capture with all patches installed provides the following functions:

· Allows each VAMC to utilize the software for its own resource/costing needs
· Implements DSS Units
· Assigns user access
· Allows single and batch data entry for patient procedures
· Generates reports for workload and other statistical tracking
· Provides a graphical user interface (GUI) to the ECS application
· Allows user to upload patient encounter data to Event Capture from a spreadsheet
· Allows user to switch between Computerized Patient Record System (CPRS) and ECS 

without having to log back into the Event Capture (EC) GUI.exe 

2.1 System Configuration
Please refer to the Event Capture Technical Manual for details related to system and site 
configuration.

2.2 Data Flows
ECS captures both inpatient and outpatient workload and uses VHA-wide standardized 
procedures which help aid benchmarking and workload analysis. ECS captures basic resource 
utilization data, creates monthly extracts, and electronically transmits to DSS, Patient Care 
Encounter (PCE), and billing offices for processing which facilitates workload analysis, cost 
analysis, and transmission of billing.
Figure 1 represents the ECS data flow.

Figure 1: ECS Data Flow Diagram
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2.3 User Access Levels
Security keys are assigned in VistA using the option Key Management main menu and then 
choosing the submenu Allocation of Security Keys.
ECS provides the following security key options for user access:

· ECMGR: Gives a user access to the ECS Management Menu — only for Event Capture 
managers.

· ECACCESS: Gives a user the ability to grant or remove access to DSS Units that they 
have access to. Note that if the user also has the ECMGR key, ECACCESS will not have 
any effect.

· ECALLU: Gives a user access to all DSS Units (super user). This key should be assigned 
only to those managing the software (i.e., holders of the ECMGR key).

· ECNORPT: Restricts the user from accessing Event Capture reports.
· ECSPSH: Gives a user access to upload data from a spreadsheet (required for State 

Veterans Home Spreadsheet upload). 

2.4 Continuity of Operations
Each site has a backup emergency plan in place in the event that the system goes down.

2.5 Section 508 Compliance
Section 508 of the Rehabilitation Act Amendments of 1998 requires that when Federal agencies 
develop, procure, maintain, or use electronic and information technology, they shall ensure that 
the electronic and information technology enables persons with disabilities to have access to, and 
use of, information and data that is comparable to the access to and use of information and data 
by persons who are not individuals with disabilities, unless an undue burden would be imposed 
on the agency.
The Section 508 Accessibility Testing and Training Center (T&TC) was consulted and 
modifications to the GUI have been made to meet the requirements for Section 508 compliance. 
Event Capture was modified to enable screen readers to accurately interpret information on the 
screens. As a result, some buttons and boxes have been moved, replaced, or renamed, and some 
screen titles have been modified.
For more information on the VA Section 508 compliance efforts, please visit the Section 508 
website.

2.5.1 Screen Readers 
ECS has been evaluated for the accessibility of application content with multiple commercial
screen readers. ECS has been tested to ensure all screens work properly when a screen reader is 
active.
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3 Getting Started
Event Capture must be set up by using the options in the Event Capture Management Menu 
before any data can be entered. Access to this menu should be restricted to the ADPAC or Event 
Capture Package Manager and his/her designees. The Event Capture ADPAC should use the 
following steps as a guide for setting up the Event Capture software.
Step 1. Select security keys. 

· See section 2.3 regarding User Access Levels for a description of ECS security keys.

Step 2. Select required VistA settings. 
· Users must be assigned the EC GUI CONTEXT VistA menu option for the ECS GUI to 

work. 

Step 3. Create an Event Capture Location. 

· Create a location using the Location — Update Location Information option. 
Note:

· The selected location must be in the INSTITUTION file (#4).
· At least one location must exist before DSS Units can be established.

Step 4. Establish DSS Units for each service. 

· Contact each service for a list of its DSS Units, the names of its Event Capture users and 
the DSS Units for which they will enter data, and for individual product resource tracking 
needs. 

· Use the DSS Unit — Add or Update DSS Units option to establish DSS Units for each 
service. 

Note:

· At least one DSS Unit must exist before Event Code Screens can be created. 

Step 5. Assign user access to specific DSS Units. 

· Use the Access by User — Grant Access to DSS Units by User option (Figure 2) to 
assign user access to specific DSS Units for the users identified in Step 4.

· Assign the ECALLU security key only to those users who should have access to all DSS 
Units. 

Note:

· Users must have access to DSS Units before they can begin entering data.
· Use the Access by User — Grant Access to DSS Units by User option to remove 

user access for a specific DSS Unit. Users with the ECALLU security key cannot 
be denied access to DSS Units.
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Figure 2: Grant Access to DSS Units by User

Step 6. Create Categories. 
· Use the Category — Add or Update Categories option to create categories before the user 

sets up Event Code Screens. 
Note:

· Creating categories is optional.
· After completion of this step, the Category Report option on the Reports Menu can 

be used to print a report of the site’s categories.

Step 7. Create or edit local procedures in the EC NATIONAL PROCEDURE file (#725). 

· Use the Procedure — Add or Update Local Procedures option to enter new, or edit 
existing, local procedures in the EC NATIONAL PROCEDURE file (#725). 

· Adding local procedures is optional and not encouraged. 

Note:

· Before starting this step, use the National/Local Procedure Report option on the 
Reports Menu to print a list of procedures with their associated CPT codes. This 
report can be quite lengthy if it includes national procedures, so it should be queued 
to print to a device during non-peak hours.

· An associated CPT code must be entered to pass local procedures to PCE.
· Use this option to edit, but not delete, existing local procedures and to select an 

associated CPT code if this workload data should be sent to PCE.
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Step 8. Use the Event Code Screen — Add or Update Event Code Screens option to: 

· Create an Event Code Screen for each procedure tracked in the Event Capture software.
· Enter or edit an optional active associated clinic for DSS Units that are marked to send 

data to PCE. If an Associated Clinic has non-conforming stop codes, the clinic will not be 
selectable.

· Enter or edit an optional procedure Synonym.
· Set Ask Reasons? radio button to Yes or No.
· Enter or edit procedure default Volume. 

Note:

· An Event Code Screen for the procedure must be created before it can be used for 
data entry. 

Step 9. Optional: Print the Event Code Screens Sorted by DSS Units 

· Use the Print Category and Procedure Summary (Report) option on the Reports Menu to 
print the Event Code Screens sorted by DSS Units. 

Note: 

· Data entry clerks might find the output generated by this report useful as a 
procedure reference guide. 

Step 10. Event Capture set up is complete. 
· Services can now enter data using the Data Entry options and provide summary reports 

using the Reports options. 

3.1 Logging On
Event Capture is accessed through a desktop shortcut that points to the location of the EC GUI 
application (Figure 3). The executable file will be located on either a local or shared network 
drive. If the shortcut does not appear, refer to the Installation Guide for Event Capture, or ask the 
local support staff for assistance.

Figure 3: ECS GUI Icon

Step 1. Double-click the EC GUI shortcut to launch the application. 

Once Event Capture is launched, there are 4 methods of providing user authentication:
· Single Sign-On (SSO) through CPRS 
· Clinical Context Object Workgroup (CCOW) 
· Personal Identification Verification (PIV) with Two-Factor Authentication (2FA) 
· Access and Verify codes 
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3.1.1 Authentication via CPRS SSO 
ECS user authentication can be achieved via SSO through CPRS. This design is intended to 
increase the use of Event Capture by clinicians currently using CPRS.
The interface between CPRS and Event Capture enables users to access Event Capture from 
within CPRS through single sign-on. This is achieved by selecting the Event Capture Interface in 
the CPRS Tool Menu which allows the user to enter Event Capture patient procedures. When 
accessing Event Capture in this way, both user and patient context are maintained. This CPRS 
feature requires set up by the local Office of Information and Technology (OIT) and/or the 
Clinical Application Coordinator.

3.1.2 Authentication via CCOW SSO 
Event Capture includes CCOW SSO capability. If a user is signed onto another CCOW SSO-
enabled system, launching Event Capture will not require the user to re-enter system Access and 
Verify codes. Likewise, if CCOW is enabled in Event Capture, other CCOW SSO compliant 
applications can use the current user’s authentication credentials from Event Capture. The status 
of the CCOW SSO is shown via an icon on a panel in the upper-right hand corner of the Main 
Menu (Figure 4). The hover help will display “Clinical Link On” if Event Capture was accessed 
with CCOW SSO enabled or “Clinical Link Off” if it was not. In addition, the icon on the panel 
will indicate current CCOW status. The CCOW feature requires set up by the local OIT.

Figure 4: Event Capture CCOW Status

3.1.3 Authentication via Personal Identification Verification  
Two-Factor Authentication adds an additional layer of security beyond a traditional username 
and password combination. Event Capture can obtain credentials from a PIV card and Personal 
Identification Number (PIN) combination. When Event Capture is first launched, it will attempt 
to use a PIV card for authentication. 
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Step 1. Select your PIV card certificate (Figure 5): 

Figure 5: PIV Certificate Selection

Step 2. Enter the PIN and press the OK button (Figure 6) 

Figure 6: PIN Entry 

 

If PIV authentication is successful, the System Use Notification will appear (Figure 7). Click the 
OK button to complete the login process.
If PIV authentication fails, the prompt for Access and Verify codes will appear.
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Figure 7: System Use Notification

3.1.4 Authentication via Access and Verify Codes 
If  PIV authentication fails, authentication will revert to the traditional Access and Verify code 
method of VistA login (Figure 8). When this happens, enter valid Access and Verify codes, and 
click the OK button.

Figure 8: VistA Login Screen
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3.2 Event Capture Main Menu
The Event Capture software contains five possible main menu options. The availability of those 
options is dependent on the keys assigned to the user:

1. Data Entry — All users have access to the Data Entry option. 
2. Spreadsheet — The user must hold the ECSPSH security key to have access to 

the Spreadsheet option. 
3. Reports — Users with the ECNORPT security key will not have access to the 

Reports option (Figure 10). 
4. Management Menu — The user must hold the ECMGR security key to have 

access to the Management Menu functions (Figure 9). Users without the ECMGR 
security key will have fewer reports available for selection than users with the 
ECMGR security key. 

5. Access by User — Users with the ECACCESS security key, but not the ECMGR 
security key, will have access to the Access by User option (Figure 11).

Figure 9: User Holds the ECSPSH and ECMGR Security Keys
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Figure 10: User Holds the ECSPSH, ECNORPT and ECMGR Security Keys

Figure 11: User Holds the ECSPSH and ECACCESS Security Keys
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3.2.1 Icon Shortcuts 
A toolbar is available with icons to access frequently used options quickly from the Main Menu 
in Event Capture (Figure 10).
Before the User Starts

· Only users with the ECSPSH security key will see the Go to the Spreadsheet Menu 
toolbar option. 

· Only users without the ECNORPT security key will see the Go to the Reports Menu 
toolbar option. 

· Only users with the ECMGR security key will see the Go to the Management Menu 
toolbar option. 

· Only users with the ECMGR security key will see the Delete Test Patient Data toolbar 
option. 

What the User Will See
· Under the menu bar on the ECS Main Menu, the toolbar presents the most frequently 

used options (Figure 12).
· The number of toolbar options visible will depend upon the individual user’s security key 

assignment. 

Figure 12: Icon Shortcuts

3.2.2 Menu Bar 
The Event Capture menu bar (Figure 13) enables the user to access shortcut commands.

Figure 13: Main Menu Bar



Event Capture System 2.0
User Guide 16 May 2025          

Before the User Starts
· Only users with the ECSPSH security key will see the Go to the Spreadsheet Menu 

toolbar option. 
· Only users without the ECNORPT security key will see the Reports Menu option under 

the Function Menu. 
· Only users with the ECMGR security key will see the Management Menu option under 

the Function Menu. 
· Only users with the ECMGR security key will see the Delete Test Patient Data option 

under the Function Menu. 

What the User Will See
· Under the Event Capture title bar on the ECS Main Menu, the menu bar presents the top-

level commands (Figure 11). 
· The File menu item enables the user to Exit the application. 
· The Function menu item on the main window provides access to:  

o Data Entry
o Spreadsheet (if the user has the proper security key)
o Reports (if the user has the proper security key)
o Management Menu (if the user has the proper security key)
o Delete Test Patient Data (if the user has the proper security key)

· The View menu item enables the user to show or hide the Toolbar and Status Bar. 
· The Help menu item provides topic-specific help, or information about the Event Capture 

system. 

Figure 14 displays the menu bar options with expanded menus.

Figure 14: Main Menu Bar with Menus Expanded

3.2.3 Delete Test Patient Data 
The Main Menu provides management users the ability to delete test patient data. Running this 
option ensures that reports will not contain test patient data. 
Before the User Starts

· Only users with the ECMGR security key will have access to the Delete Test Patient Data 
option. 

· The Delete Test Patient Data option is only available on the ECS Main Menu. 
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· Test patient data entered for DSS Units CH103-109 is excluded from deletion when 
running this option. 

What the User Will See
· After selecting the Delete Test Patient Data option from the ECS Main Menu (menu bar 

or toolbar), a Delete Test Patient dialog box will display (Figure 15).
· The Delete Test Patient dialog box informs the user to which account he or she is 

connected, the date and time the option was last run (if available) and the name of the 
person that last performed the option. The dialog also contains a warning message 
informing the user that deletion cannot be undone. 

Figure 15: Delete Test Patient Data Dialog Box

3.3 Menu Bar for Specific Functions
The menu bar for the four ECS functions are described in the following subsections.

3.3.1 Data Entry Menu Bar 
The Data Entry menu bar consists of the File, Edit, View, and Help menus (Figure 16).

Figure 16: Data Entry Menu Bar Options

· The File menu item provides the option for the user to exit the window. 
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· The Edit menu item provides access to Data Entry by Patient, Data Entry by Procedure, 
and Multiple/Multiple functions. 

· The View menu item enables the user to show or hide the Toolbar and Status Bar. 
· The Help menu item provides topic-specific help, or information about the Event Capture 

System. 

Figure 17 shows the Data Entry menu bar options with the expanded menus.

Figure 17: Data Entry with Menus Expanded

3.3.2 Spreadsheet Menu Bar 
The Spreadsheet menu bar consists of the File, Edit, EC Upload, Spreadsheet Options (if the user 
has the proper security key), and Help menus (Figure 18).

Figure 18: Spreadsheet Menu Bar Options

· The File menu item enables the user to Exit the window as well as Open Spreadsheet, 
Open State Veterans Home Spreadsheet, Close, Save, Save As, and Print a file. 

· The Edit menu gives the user the option to Undo, Cut, Copy, Paste, Insert Row, Delete 
Row, Insert Column, or Delete Column. 

· The EC Upload menu item enables the user to Upload Records to VistA. 
· The Spreadsheet Options menu item enables the user to Change Column Headers or 

Change Duplicate Threshold. 
· The Help menu item provides topic-specific help, or information about the Event Capture 

System. 

Figure 19 shows the Spreadsheet menu bar options with the expanded menus.

Figure 19: Spreadsheet Menu Bar with Menus Expanded
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3.3.3 Reports Menu Bar 
The Reports menu bar consists of the File, View, and Help menus (Figure 20).

Figure 20: Reports Menu Bar Options

· The File menu item enables the user to Exit the window. 
· The View menu item enables the user to show or hide the Toolbar and Status Bar. 
· The Help menu item provides topic-specific help, or information about the Event 

Capture System. 

Figure 21 shows the Reports menu bar options with the expanded menus.

Figure 21: Reports Menu with Menus Expanded

3.3.4 Management Menu Bars 
The Event Capture Management Menu bar consists of the File, Table, View, and Help menus 
(Figure 22).

Figure 22: Management Menu Options

· The File menu item enables the user to Exit the window. 
· The Table menu item provides access to Location, DSS Unit, Access by User, Category, 

Procedure, Reason, Event Code Screen, Inactivate EC Screen, and Providers functions. 
· The View menu item enables the user to show or hide the Toolbar and Status Bar. 
· The Help menu item provides topic-specific help, or information about the Event Capture 

system. 
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Figure 23 shows the expanded Management Menu bar options with expanded menus.

Figure 23: Management Menu with Menus Expanded

3.4 Changing User ID and Password
If PIV authentication is unavailable, users will need to use VistA access and verify codes to 
access ECS. To request changes to assigned access and verify codes, please contact the Office of 
Information Technology (OIT).

3.5 Exit System
From the Event Capture Main Menu, click the Exit button to exit the Event Capture GUI. 
Alternatively, from the same screen, users can go to File > Exit, or click the Close window 
button in the top-right corner of the screen.

3.6 Caveats and Exceptions
On all ECS GUI screens, the previous Location entry will be saved and used as the default on 
subsequent Location fields.

3.7 Online Documentation
Online help is available throughout the entire ECS GUI. To obtain online information for any 
screen, click the question mark button located on the toolbar or at the bottom-right corner of 
the screen, click the Topic Help button . The information provided in the help menus 
corresponds to the information that is in this User Guide (Figure 24).
To obtain online information for a field, select that field and then press the <F1> key.
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Figure 24: Online Help Screen Example

3.8 Timeout Feature
Event Capture includes a timeout feature consistent with CPRS. A countdown screen will display 
a warning of the pending timeout of the application when the Event Capture application is idle 
for a user-defined amount of time. If the user takes no action, the application will close. Click the 
“Do not close Event Capture” button to stay connected (Figure 25).

Figure 25: Event Capture Timeout Screen

The amount of time for the timeout feature is user-defined at the application server level.
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4 Using the Software 
The following subsections detail the Event Capture Main Menu options (Figure 9). Instructions 
are provided on how to perform tasks in each of the four main areas: 

1. Data Entry
2. Spreadsheets
3. Reports
4. Management Menu

4.1 Data Entry Menu
The Data Entry Menu offers three options (Figure 26):

1. Data Entry by Patient — Enter/Edit Patient Procedures
2. Data Entry by Procedure — Batch (Same Procedure, Multiple Patients)
3. Multiple Dates/Procs — Multiple Dates / Multiple Procedures

Figure 26: Data Entry Menu 
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4.1.1 Data Entry by Patient 
The Data Entry by Patient allows the user to enter a single procedure for one patient, edit an 
existing patient procedure, or delete an existing patient procedure. 
Before the User Starts

· Event Code Screens must be defined before entering any Event Capture data. 

What the User Will See
· After selecting the Data Entry by Patient option, the Enter/Edit Patient Procedures screen 

will display (Figure 27), allowing the user to search by the Location, DSS Unit, 
Procedure Date Range, and Patient Identifier.

· After entering the desired selection criteria, any existing procedures for the selected 
patient will appear (Figure 29).

Figure 27: Enter/Edit Patient Procedures Screen
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4.1.1.1 Enter/Edit Patient Procedures Screen 
To use the Enter/Edit Patient Procedures screen:
Step 1. Select a Location. 

· If there is only one Location set up in ECS, the Location on the screen will default to that 
value. 

· If there is more than one Location set up in ECS, the Location on the screen will default 
to the last Location used. To change the Location, choose a Location from the dropdown 
list. 

Step 2. Select a DSS Unit. 

· If only one DSS Unit is assigned to the user, it will be the default selection. If more than 
one DSS Unit is assigned to the user, choose a DSS Unit from the dropdown list of 
accessible DSS Units. 

· The user can add, edit, or delete any patient procedure for the selected DSS Unit.  
Note:

· Be aware that any DSS Unit can be affected. Users should use caution and only 
add, delete, or modify DSS Units that they manage. 

· To gain access to a DSS Unit, go the Management Menu and choose the DSS Unit — 
Add or Update DSS Units function to add the unit to the dropdown list. The ECMGR key 
is required. 

Step 3. Select a Date Range. 
· The Procedure Date Range (from/through) will default to the system date. These fields 

may be edited by typing in a date (DD MMM YYYY) or by using the calendar dropdown 
(Figure 28).

Note:

· Date validation will prevent selecting a date in the future or displaying a Procedure 
From date later than the Procedures Through date. 

Figure 28: Calendar Dropdown for Date Range View

Step 4. Use the Patient Identifier field to select a patient. 

· Enter one of the following: 
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o Patient Name (whole or partial, last name first)
o Social Security Number (SSN)
o Last four digits of the Patient Social Security Number
o First character of Last Name plus the last four digits of the SSN with no spaces

· Press <Enter> on the keyboard or click the Search button. 
· Choose from the list of patients displayed. 

Step 5. View the Patient Procedures. 

· Once the previous steps are complete, the bottom section of the window will display the 
patient procedures in chronological order for the selected search criteria (Figure 29). 
Each record will display the Category, Procedure, Date/Time, Volume, Associated 
Clinic, Ordering Section, Primary Diagnosis, and Primary Provider.

Note:

· Click the column header to sort the data in a different order.
· The Close, Add, and Topic Help buttons are always enabled. If patient procedures 

exist, the Update and Delete buttons will also be enabled.
· Click to highlight a patient procedure to select that row for updating or deleting. 

Figure 29: Procedure History for Sample Patient

Step 6. To modify patient procedures, choose from the following button options: 

· Add — Click the button to enter a new patient procedure. 
· Update — Click the button to edit the selected patient procedure. 
· Delete — Click the button to delete the selected patient procedure. 
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4.1.1.2 Recent Visits Screen 
To see the Recent Visits screen (Figure 30):

Step 1. On the Enter/Edit Patient Procedures screen, click the Add button to enter a new patient 
procedure. 

Note: 

· If the selected DSS Unit is set to send to PCE and recent visits exist, the Recent 
Visits screen will be displayed after clicking the Add button. 

Figure 30: Recent Visits Screen

Step 2. Selection options on the Recent Visits screen. 

One can select current day encounters from the Recent Visits, even if they occur after the current 
time. However, appointments and encounters that occur after the end of the current day will not 
be available for selection.

· On the Recent Visits screen, the user can choose one of three options: 
1. OK: Select the appropriate Appointment/Encounter from the Recent Visits. Click the 

OK button to close the screen. The Add Patient Procedure screen opens with the 
Procedure Date/Time and Associated Clinic fields pre-populated and not modifiable, 
based on the Appointment/Encounter selected on the Recent Visits screen (Figure 
31). The Diagnosis field will also pre-populate, but information in this field can be 
modified by the user.  
Enter the procedure(s), answer classification questions as they pertain to that visit, 
and provider, and other pertinent fields if required (reasons, ordering section, and/or 
modifiers).

2. Ignore: Click the Ignore button on the Recent Visits screen to go to the Add Patient 
Procedure screen to enter information for all fields.

3. Cancel: Click the Cancel button to close the Recent Visits screen and return to the 
Enter/Edit Patient Procedures screen.
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Figure 31: Add Patient Procedure Detail Screen

· To update the record, select an active clinic from the list and then click the OK button. 
Note:

· If the Associated Clinic for the selected record is no longer active, clicking the OK 
button will result in the display of the Error: Invalid Associated Clinic message 
dialog (Figure 32). The message dialog lists only active Associated Clinics.

· A clinic must exist in the CLINICS AND STOP CODES file (#728.44) prior to 
being available for selection in any Data Entry options.

· If an Associated Clinic has non-conforming stop codes, the clinic will not be 
selectable.

· Click the Cancel button to open the record and the Associated Clinic field will be blank. 
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Figure 32: Error: Invalid Associated Clinic Message Dialog

4.1.1.3 Enter Information on the Add Patient Procedure or Edit Patient 
Procedure Screen 

The user can add or edit patient procedures performed on an individual patient using the Add 
Patient Procedure screen, or the Edit Patient Procedure screen.
The following instructions and example assume that a user is entering a new procedure for a 
specified patient, and that the specified DSS Unit transmits data to PCE.
Step 1. Select a Category. 

· If the Allow Category Use field in the DSS Unit Management setup is set to NO, then the 
Category field will be blank and disabled. 

· If the Category field is defined for the specified DSS Unit, that Category will be the 
default value. 

Step 2. Select the Procedure Date and Time. 

· The Procedure Date and Time field is not editable if a recent visit was selected on the 
Recent Visits screen. 

· Typing <N> on the keyboard and then pressing <Enter> (instead of clicking the  
button) will populate the Procedure Date & Time field with the current date and time, and 
will bypass the Select Date/Time dialog box (Figure 33).

· Clicking the Now button in the dialog box will enter the current system date and time. 
· Clicking the Midnight button will display “23:59” as the time on the selected date. 
· Until a valid date and time are selected, fields after the Procedure Date and Time field are 

not visible. Once a valid date and time are selected, the remaining fields become visible 
and available for input. 
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Figure 33: Select Date/Time Dialog Box

Step 3. Select an Eligibility Code for this procedure. 

· If the selected patient has only one Eligibility Code, that value defaults. Otherwise, select 
the Eligibility Code that applies to this procedure. 

· The primary Eligibility Code displays as the default. 

Step 4. Select a Procedure Name. 

· Select a Procedure from the dropdown list. 

Step 5. Enter the Volume for the procedure.
Step 6. If applicable, the CPT Modifiers section will be enabled.

· Modifiers provide additional information about a CPT procedure. With functionality put 
in place by the Code Set Versioning project, only CPT modifiers that are active for the 
date and time of the event will show. 

· Choose a modifier from the Modifiers Available list and click Include. 
· Repeat as needed. 
· To remove a modifier, choose it from the Modifiers Selected list and click Exclude. 
· Press and hold the <Ctrl> key, and then click items to select multiple modifiers at one 

time. 

Step 7. If applicable, the Reasons field will be enabled. 

· The user can enter up to three reasons. 
· Reason #1 must be entered before a second or third may be entered. Reason #2 must be 

entered before a third may be entered. 
· Reasons appear alphabetically in the dropdown. 
· Once selected, a reason will not appear in the dropdown list for remaining reason fields. 
· A reason can be selected by entering the initial letter(s) into the Reasons field. If the 

reason that appears is not the correct choice, click the down arrow on the reason 
dropdown to select another reason, or enter different letter(s). 
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Step 8. If applicable, the mandatory classification questions section will be enabled. 

· Select YES only if the treatment received relates to that classification. 
· Press the <F1> key while in the Service Connected field to display a message dialog 

containing the patient’s service connection and any rated disabilities (Figure 34).

Figure 34: Service Connection and Rated Disabilities Screen

Step 9. Select the Ordering Section.
Step 10. Select the Associated Clinic (if not already populated from the Recent Visits screen).

Note

· A clinic must exist in file #728.44 Clinics and Stop Codes prior to being available 
for selection in any Data Entry options.

· If an Associated Clinic has non-conforming stop codes, the clinic will not be 
selectable.

Step 11. Select the associated diagnosis code for the procedure (Figure 35). 

Note 

· If a recent visit is selected from the Recent Visits screen, the diagnoses box may be 
pre-populated; diagnoses can be added and removed by the user, as desired. 

· Search for a diagnosis by entering one of the following in the Dx (Diagnosis) Lookup 
box: 
o International Classification of Diseases (ICD) code (whole or partial)
o Diagnosis Name (whole or partial)

· Click the Binoculars (Search) button to the right of the Dx Lookup box or press <Enter> 
to begin the search. 

· Select from the resulting dropdown list and click the Add Dx to List button to place the 
desired diagnosis in the Diagnoses box. The user can also double-click on a diagnosis to 
add it to the list. 
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Note

· If an ICD code is used to search for a diagnosis, the user can press < Enter > to 
place the diagnosis in the Diagnoses box.  

· Repeat as needed to select and add multiple diagnoses. 
· Existing diagnoses for the patient procedures, as shown in the Diagnoses box, may be 

removed, and the Primary Diagnosis may be changed by selecting a diagnosis and using 
the associated buttons to the left of the Diagnoses box. The primary diagnosis will 
always be the first entry in the diagnosis box.  

Figure 35: Data Entry Diagnoses Box

Step 12. Optional: Click the Problem List button (Figure 35) to open a list of problems for a patient 
with the following details (Figure 36):  

o  Status
o  ICD Code with Description 
o  Onset Date
o Last Updated
o Provider
o Service

· The user may add a diagnosis to the list by double-clicking an item from the Problem List 
or by selecting an item from the Problem List and clicking the Add Dx to List button. 
Items with inactive ICD codes cannot be added to the diagnoses box and will return an 
error message if selected. 

· If no information exists for the Problem List, a message dialog is displayed stating 
“There are no items in the problem list for NAME, PATIENT (XXX-XX-XXXX) DOB: 
m/d/yyyy.”
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Figure 36: Problem List

Step 13. Select the providers of the service. Use the Providers Available combo box to enter the 
following: 

· Provider name (full or partial, last name first). 
· Select the provider from the resulting dropdown list and click the Include button. 
· To remove a provider, select from the Providers Selected list and click the Exclude 

button. 

Step 14. Click the Add button to file the current procedure and clear the fields, allowing for input 
of additional procedures for the selected patient.

Step 15. Click the OK button to file the current procedure and return to the Enter/Edit Patient 
Procedures screen.

Step 16. Click the Cancel button to return to the Enter/Edit Patient Procedures screen without 
filing the procedure.

Note:

· If the record transmits to PCE based on the DSS Unit on Management Menu set up, 
then all fields will be required.

· If the record does not transmit to PCE based on the DSS Unit on Management 
Menu set up, then the Associated Clinic and Diagnosis fields will be disabled.

· Occasion Of Service records will not require answers to Classification questions 
and will not require any diagnosis values.

· Press the <F1> key while in any field to display information pertaining to that field.

4.1.1.4 Add a Patient Procedure 
The following instructions and example assume that a user is entering a patient procedure for a 
specified patient and that the specified DSS Unit transmits data to PCE. To add multiple 
procedures for a patient, see section 4.1.1.5 Add Multiple Patient Procedures.

Step 1. On the Event Capture Main Menu, select Data Entry.
Step 2. On the Data Entry Menu, select Data Entry by Patient.
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· The Enter/Edit Patient Procedures screen appears (Figure 37).

Step 3. Select the Location and DSS Unit.
Step 4. Allow the Procedure Date Range to default to today.
Step 5. Select a Patient.

Figure 37: Enter/Edit Patient Procedures Screen

Step 6. Click Add.
Step 7. If the DSS Unit is set to send to PCE, the Recent Visits screen will appear (Figure 38). 

Select a scheduled appointment and click OK.

Figure 38: Recent Visits Screen
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Step 8. Complete the procedure-related fields on the Add Patient Procedure screen (Figure 39) 
according to the field-by-field instructions given in Section 4.1.1.3 — Add Information to the 
Add Patient Procedure or Edit Patient Procedure Screen

Figure 39: Add Patient Procedure Screen

Step 9. Click Add to file the record and clear the fields, allowing for input of another procedure 
for this patient. Users may also opt to use the Multiple Procedures feature to input multiple 
patient procedures at one time. 

Step 10. Click the OK button to save the record and return to the Enter/Edit Patient Procedures 
screen.

Step 11. The Enter/Edit Patient Procedures screen displays any existing procedures for this 
patient (Figure 40).
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Step 12. Click the Close button to return to the Data Entry menu.

Figure 40: Enter/Edit Patient Procedures with New Procedure Added

4.1.1.5 Add Multiple Patient Procedures 
The following instructions and example assume that a user is entering multiple procedures for a 
specified patient and that the specified DSS Unit transmits data to PCE.

Step 1. On the Event Capture Main Menu, select Data Entry.
Step 2. On the Data Entry Menu, select Data Entry by Patient.

· The Enter/Edit Patient Procedures screen appears (Figure 41).

Step 3. Select the Location and DSS Unit.
Step 4. Allow the Procedure Date Range to default to today.
Step 5. Select a Patient.
Step 6. Click Add.
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Figure 41: Enter/Edit Patient Procedures Screen

Step 7. If the DSS Unit is set to send to PCE, the Recent Visits screen will appear (Figure 38).
The user can bypass this screen and go directly to the Add Patient Procedure screen by 
clicking the Ignore button. 
The user can select a visit from the list and click the OK button to partially populate the Add 
Patient Procedure screen (Figure 46) with the following:

· Date/Time 
· Associated Clinic 
· Diagnoses 

Figure 42: Recent Visits screen
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Step 8. Once the Add Patient Procedures screen is open, select the square button to the left of 
the Procedure Name field to enter multiple procedures (Figure 43).  
When selected, the field will display “The Multiple Procedures feature is in use.”

Note:

· The Add button for this screen will be disabled when the Multiple Procedures 
feature is used. 

Figure 43: Multiple Procedures Button

Step 9. The Enter Multiple Procedures for an Encounter screen opens (Figure 44).
Step 10. Input data into the available fields. Refer to section 4.1.1.3 for more detailed field 

instructions:

· Procedure Name — Select a Procedure from the dropdown list. 
· Volume — Enter the Volume for the procedure. 
· Reasons — The user can enter up to three reasons, which appear alphabetically in the 

dropdown menus. 
· Modifiers Selected — Choose a modifier from the Modifiers Available list and click the  

Include button. To remove a modifier, choose it from the Modifiers Selected list and 
click the Exclude button. To select multiple modifiers at one time, press and hold the 
<Ctrl> key, and then click the appropriate button to include or exclude items. 

Step 11. Select the Add Procedure button to place information in the Procedures Selected box. 
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Step 12. Repeat steps 10 and 11 to add procedures to the list, as desired. The number of 
procedures added by the user is shown in brackets beside the Procedures Selected label. 

Figure 44: Enter Multiple Procedures for an Encounter screen

Step 13. Optional: A procedure can be removed by selecting it from the list and clicking the 
Delete Procedure button. 

Step 14. Optional: Details of individual procedures can be viewed by selecting a procedure from 
the list and clicking on the View Details button. The View Procedure Record Details screen 
opens (Figure 45). Select the Close Procedure View button to return to the previous screen or 
select OK to return to the Add Patient Procedure Screen (Figure 46).

Figure 45: View Procedure Record Details
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Step 15. Click the OK button to return to the Add Patient Procedure screen when finished (Figure 
46). 

Figure 46: Add Patient Procedure Screen 

 

Step 16. Complete the active fields on the Add Patient Procedure detail screen. Refer to section 
4.1.1.3 for more detailed field instructions: 

· Procedure Date & Time — Select a valid date and time (if not already populated by the 
Recent Visits screen). 

· Encounter Related — Select YES only if the treatment received relates to that 
classification. 

· Ordering Section — Select the Ordering Section. 
· Associated Clinic — Select the Associated Clinic (if not already populated from the 

Recent Visits screen). 
· Diagnoses — Select the diagnosis code(s) associated with the procedure; if populated 

from the Recent Visits screen, diagnoses can be edited.  
· Providers Available — Select the provider(s) of the service. 
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Note:

· If a recent visit was selected from the Recent Visits screen, the Procedure Date & 
Time and Associated Clinic will be pre-populated and are not editable. The 
Diagnoses field will also be pre-populated but is editable by the user. 

Step 17. Click the OK button to save the record and return to the Enter/Edit Patient Procedures 
screen.

Step 18. The Enter/Edit Patient Procedures screen displays any existing procedures for this 
patient (Figure 40).

Step 19. Click the Close button to return to the Data Entry menu.

4.1.1.6 Edit a Patient Procedure 
Step 1.  On the Event Capture Main Menu, select Data Entry.
Step 2. On the Data Entry Menu, select Data Entry by Patient.
Step 3. The Enter/Edit Patient Procedures screen appears (Figure 47).

Figure 47: Enter/Edit Patient Procedures Screen

Step 4. Select the Location and DSS Unit.
Step 5. Enter a Procedure Date Range by using the calendar dropdowns.

· The date fields default to the current system date. 

Step 6. Select a patient.
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Step 7. The lower portion of the screen displays the procedure(s) for the selected patient and the 
DSS Unit within the date range.

Step 8. Select a procedure and click the Update button.

· The Edit Patient Procedure screen appears (Figure 48).

Figure 48: Edit Patient Procedure Screen

Step 9. Complete the procedure-related fields on the Edit Patient Procedure detail screen 
according to the field-by-field instructions given in Section 4.1.1.3.

Step 10. Click the Add button to file the record and clear the fields, allowing for input of another 
procedure for this patient.

Step 11. Click the OK button to save the record and return to the Enter/Edit Patient Procedures 
screen.
· The Enter/Edit Patient Procedures summary screen displays the procedure(s) (Figure 47) 

entered for this patient.

Step 12. Click the button to return to the Data Entry menu. 
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4.1.1.7 Delete a Patient Procedure 
This section instructs the user on how to delete a Patient Procedure.
Step 1. On the Event Capture Main Menu, select Data Entry.
Step 2. On the Data Entry Menu, select Data Entry by Patient.

· The Enter/Edit Patient Procedures summary screen appears (Figure 49).

Figure 49: Enter/Edit Patient Procedures Screen

Step 3. Select the Location and DSS Unit.
Step 4. Enter a procedure date range by using the calendar dropdowns.

· The date fields default to the current system date. 

Step 5. Select a patient.
Step 6. The lower portion of the screen displays the procedure(s) for the selected location, DSS 

Unit and patient within the date range.
Step 7. Choose a procedure and click the Delete button.

· A confirmation message appears (Figure 50).

Figure 50: Procedure Deleted Confirmation Dialog
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· Click the Yes button on the confirmation message dialog, and an Information message 
dialog appears to show the selected procedure was deleted for the patient (Figure 51). 
Click the OK button to return to the Enter/Edit Patient Procedures screen.

· Click the No button on the confirmation message dialog to return to the Enter/Edit Patient 
Procedures screen without deleting the procedure. 

Figure 51: Information Message

· The screen will refresh to show the remaining procedures entered for this patient (Figure 
52).

Step 8. Click the Close button to return to the Data Entry menu. 

Figure 52: Enter/Edit Patient Procedures Screen with Procedure Deleted 
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4.1.2 Data Entry by Procedure 
The Data Entry by Procedure option allows the user to enter or edit the same procedure for 
multiple patients. 
Before the User Starts

· Event Code Screens must be defined before entering any Event Capture data. 

What the User Will See
· After selecting Data Entry by Procedure, the Same Procedure, Multiple Patients screen 

will display (Figure 53).
· The left side of the screen contains information for the procedure that the system will use 

for all patients.  
Note: 

· The user will enter the procedure information only one time. 

· The right side of the screen identifies each patient. The user will complete this section for 
each patient. Click the Add button to file the data and clear the fields to enter data for the 
next patient. 

· The View button displays a listing of all patients entered for this procedure in this 
session. 

Figure 53: Same Procedure, Multiple Patients Screen
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4.1.2.1 Add a Procedure for Multiple Patients 
The following instructions and example assume that the user wants the specified DSS Unit to 
send data to PCE.
Step 1. Select a Location. 

· If there is only one Location set up for the Event Capture System, the Location on the 
screen will default to that value. 

· If there is more than one Event Capture Location set up, the Location will default to the 
last Location used. To change the Location, choose a Location from the dropdown list of 
available Event Capture Locations. 

Step 2. Select a DSS Unit. 

· If one DSS Unit is defined in Event Capture, or if only one DSS Unit is assigned to the 
user, that DSS Unit will be the default value. 

· If more than one DSS Unit is defined, a default will not be assigned. Choose a DSS Unit 
from the dropdown list of accessible DSS Units. 

· To gain access to a DSS Unit, go to the Management Menu and choose the DSS Unit — 
Add or Update DSS Units function to add the unit to the dropdown list. 

Step 3. Select a Category. 
· If only one category is defined for the specified DSS Unit, that category will be the 

default. 

Step 4. Select the Procedure Date and Time. 

· Typing <N> and then pressing <Enter> in the field (instead of clicking the  button) 
will bypass the Select Date/Time dialog (Figure 54). If the Select Date/Time dialog is 
displayed, click the Now button to enter the current system date and time. When the 
Midnight button is clicked, “23:59” is displayed for the time on the date selected. 

· Until a valid date and time are selected, fields after the Procedure Date and Time field are 
not visible. Once a valid date and time are selected, the remaining fields become visible 
and available for input. 

Figure 54: Select Date/Time Dialog
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Step 5. Select a Procedure Name. 

· Select a procedure from the dropdown list. 

Step 6. If applicable, the Reasons field will be enabled. 

· The user can enter up to three reasons. 
· Reason #1 must be entered before a second or third may be entered. Reason #2 must be 

entered before a third may be entered. 
· Reasons appear alphabetically in the dropdown. 
· A reason will not appear in the dropdown list for remaining reason fields as an option 

once selected. 
· A reason can be selected by entering the initial letter(s) in the Reasons field. If the reason 

that appears is not the correct choice, click the down arrow on the reason dropdown to 
select another reason. or enter different letter(s). 

Step 7. If applicable, the CPT Modifiers section will be enabled. 
· Modifiers provide additional information about a CPT procedure. With functionality put 

in place by the Code Set Versioning project, only CPT modifiers that are active for the 
date and time of the event will show. 

· Choose a modifier from the Modifiers Available list and click the right pointer icon . 
Repeat as needed. 

· To remove a modifier, choose it from the Modifiers Selected list and click the left pointer 

icon .
· Press and hold the <Ctrl> key, and then click items to select multiple modifiers at one 

time. 

Step 8. Select the providers of the services. Use the Providers Available text box to enter the 
following: 

· Provider name (full or partial, last name first) 

· Select the provider from the resulting dropdown list and click the right pointer icon .
· To remove a provider, select from the Providers Selected list and click the left pointer 

icon .

Step 9. Use the Patient Identifier field to select a patient. 

· Enter one of the following: 
o Patient Name (whole or partial, last name first)
o Social Security Number
o Last four digits of the Patient Social Security Number
o First character of Last Name plus the last four digits of the SSN with no spaces

· Press <Enter> on the keyboard or click the Binoculars (Search) button.  
· Choose from the list of patients displayed. 
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Step 10. Select an Eligibility Code for this procedure. 

· If the selected patient has only one Eligibility Code, that value defaults. Otherwise, select 
the Eligibility Code that applies to this procedure. 

· The primary Eligibility Code displays as the default. 

Step 11. Enter the Volume for the procedure.
Step 12. If applicable, the mandatory classification questions section will be enabled.

· Select YES only if the treatment received relates to that classification. 
· Pressing the <F1> key while in the Service Connected field will open a message dialog 

displaying the patient’s service connection and any rated disabilities (Figure 55).

Figure 55: Service Connection and Rated Disabilities Dialog

Step 13. Select the Ordering Section.
Step 14. Select an Associated Clinic for the specified DSS Unit, if applicable.

Note

· A clinic must exist in file #728.44 Clinics and Stop Codes prior to being available 
for selection in any Data Entry option.

· If an Associated Clinic has non-conforming stop codes, the clinic will not be 
selectable.

Step 15. Select the associated diagnosis code for the procedure.  
· Search for a diagnosis by entering one of the following in the Dx (Diagnosis) Lookup 

box (Figure 56):
o International Classification of Diseases (ICD) code (whole or partial)
o Diagnosis Name (whole or partial)

· Click the Binoculars (Search) button to the right of the Dx Lookup box or press <Enter> 
to begin the search. 
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· Select from the resulting dropdown list and click the Add Dx to List button to place the 
desired diagnosis in the Diagnoses box. The user can also double-click on a diagnosis to 
add it. 

Note

· If an ICD code is used to search for a diagnosis, the user can press <Enter> to 
place the diagnosis in the Diagnoses box. 

· Repeat as needed to select and add multiple diagnoses. 
· Values in the Diagnoses box may be removed, or the Primary Diagnosis may be changed, 

by selecting a diagnosis and using the associated buttons to the left of the Diagnoses box. 
The primary diagnosis will always be the first entry in the Diagnoses box.  

Figure 56: Same Procedure, Multiple Patients, Data Entry Diagnoses Box

Step 16. Repeat steps 9 through 15 to add the same procedure for another patient.
Step 17. Click the View button to verify that the list of patients entered is correct.

· The View Patients for this Procedure screen will list all the patients entered for the 
procedure that was selected (Figure 57).

Step 18. When all patients have been added for the current procedure, click the OK button to file 
the records, or click the Cancel button to return to the Data Entry menu without filing the 
records.

Step 19. To correct an entry, return to the Data Entry menu and select Data Entry by Patient.
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Figure 57: View Patients for this Procedure Screen

4.1.3 Multiple Dates/Multiple Procedures 
The Multiple Dates/Multiple Procedures option allows the user to add multiple dates and 
multiple patients for multiple procedures.
Before the User Starts

· Event Code Screens must be defined before entering any Event Capture data. 

What the User Will See
· After selecting Multiple Dates/Multiple Procedures from the Data Entry Menu, the 

Multiple Dates/Multiple Procedures screen displays (Figure 58).
· The area at the top of the first screen provides common fields (Location, DSS Unit, and 

Category) as well as the Procedure Date/Time. 
· The first three tabs allow the user to enter providers, procedures, and patients (Providers, 

Procedures, and Select Patient). 
· The last two tabs allow the user to check the work before submitting (View Selected 

Patients and Records Pending Filing). The number of patients selected and the number of 
records pending are displayed on the tab headers.  
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Figure 58: Multiple Dates/Multiple Procedures Screen — Initial Screen

4.1.3.1 Instructions for Common Fields 
Step 1.  Select a Location. 

· If there is only one Location set up for the Event Capture System, the Location on the 
screen will default to that value. 

· If there is more than one Event Capture Location set up, the Location will default to the 
last Location used. To change the Location, choose a Location from the dropdown list of 
available Event Capture Locations. 

Step 2. Select a DSS Unit. 

· If one DSS Unit is defined in Event Capture, or if only one DSS Unit is assigned to the 
user, that DSS Unit will be the default value. 

· If more than one DSS Unit is defined, a default will not be assigned. Choose a DSS Unit 
from the dropdown list of accessible DSS Units. 

· To gain access to an existing DSS Unit, the Event Capture Manager must assign it to the 
user. 

Step 3. Select a Category. 

· If categories are not allowed in the DSS Unit, the selection box will be disabled. 
· If only one category is defined for the specified DSS Unit, that category will be the 

default. 
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Step 4. Select the Procedure Date and Time by using the Select Date/Time dialog (Figure 59). 

Figure 59: Select Date/Time Dialog

· Select date and time and click the OK button to close the dialog. 
· Click the Add Date/Time button to add the choice to the Selected Dates / Times list. 
· Select and add dates as needed. 
· To remove a date, choose it from the list and click the Delete Date/Time button. 

Note:

· The Procedure Date/Time field defaults to the current system date and time. 

· To enter the current system date and time, click the Now button on the Select Date/Time 
dialog. 

· When the Midnight button is clicked, “23:59” is displayed as the time on the date 
selected. 

Step 5. Click and complete the tabs for Providers, Procedures and Select Patient as described in 
the following sections: 

4.1.3.2 — Add Information to the Providers Tab

4.1.3.3 — Add Information to the Procedures Tab

4.1.3.4 — Add Information to the Select Patient Tab

Step 6. Use the View Selected Patients and Records Pending Filing tabs to check the work as 
described in the following sections: 

4.1.3.5 — Verify Information Using the View Selected Patients Tab

4.1.3.6 — Verify Information Using the Records Pending Filing Tab

Step 7. Click the Save button at the bottom of the screen to process the transactions shown on 
the Records Pending Filing tab and continue to enter a new set of entries.

Step 8. Click the OK button at the bottom of the screen to process the transactions shown on 
the Records Pending Filing tab, and then return to the Data Entry menu.
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4.1.3.2 Add Information to the Providers Tab 
Step 1.  Click the Providers tab to select one or more providers (Figure 60). 

Figure 60: Multiple Dates/Multiple Procedures Screen, Providers Tab

Step 2. Select a Provider. 

· Use the Providers Available list to enter the full or partial provider name (last name first). 
· Select the provider from the resulting dropdown list and click the Include button. 
· To remove a provider, select from the Providers Selected list and click the Exclude 

button. 

Step 3. Repeat as needed to add providers. 
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4.1.3.3 Add Information on the Procedures Tab 
Step 1.  Click the Procedures tab to select one or more procedures (Figure 61). 

Figure 61: Multiple Dates/Multiple Procedures Screen, Procedures Tab

Step 2. Select a Procedure Name. 

· Select a procedure from the dropdown list. 

Step 3. Enter the Volume for this procedure.
Step 4. If applicable, the Reasons field will be enabled.

· The user can enter up to three reasons. 
· Reason #1 must be entered before a second may be entered. Reason #2 must be entered 

before a third may be entered. 
· Reasons appear alphabetically in the dropdown. 
· A reason will not appear in the dropdown list for remaining reason fields as an option 

once selected. 
· A reason can be selected by entering the initial letter(s) in the Reasons field. If the reason 

that appears is not the correct choice, click the down arrow on the reason dropdown to 
select another reason, or enter different letter(s). 

Step 5. If applicable, the Modifiers section will be enabled. 

· Modifiers provide additional information about a CPT procedure. With functionality put 
in place by the Code Set Versioning project, only CPT modifiers that are active for the 
date and time of the event will display. 

· Choose a Modifier from the Modifiers Available list and click the Include button. 
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· Repeat as needed. 
· To remove a modifier, choose it from the Modifiers Selected list and click the Exclude 

button. 
· Press and hold the <Ctrl> key, and then click items to select multiple modifiers at one 

time. 

Step 6. Click the Add Procedure button to add this procedure to the Procedures Selected list and 
display a blank screen ready for another entry.

Step 7. To add another procedure, repeat the steps above.

Note

· Diagnoses which exist for the same location, procedure date/time, Associated Clinic 
and patient will be retrieved when those key fields are encountered for a new 
procedure. 

Step 8. To delete a procedure, choose it from the Selected Procedures list and click the Delete 
Procedure button.

Step 9. To view a procedure in an expanded format, choose it from the Selected Procedures list 
and click the View Details button. The View Procedure Record Details screen (Figure 62) is not 
editable.

Step 10. Click the Close Procedure View button to return to the Procedures tab

Figure 62: View Procedure Record Details Screen
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4.1.3.4 Add Information to the Select Patient Tab 
Step 1.  Click the Select Patient tab to select one or more patients (Figure 63). 

Figure 63: Multiple Dates/Multiple Procedures Screen, Select Patient Tab

Step 2. Use the Patient Identifier field to select a patient. 

· Enter one of the following: 
o Patient Name (whole or partial, last name first)
o Social Security Number
o Last four digits of the patient Social Security Number
o First character of Last Name plus the last four digits of the SSN with no spaces

· Press <Enter> or click the Binoculars (Search) button.  
· Choose from the list of patients displayed. 

Step 3. Select an Eligibility Code for this procedure. 
· If the selected patient has only one Eligibility Code, that value defaults. Otherwise, select 

the Eligibility Code that applies to this procedure. 
· The primary Eligibility Code displays as the default. 

Step 4. If applicable, the mandatory Encounter Related classification questions section will be 
enabled. 

· Select YES only if the treatment received relates to that classification. 
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· Pressing the <F1> key while in the Service Connected field will open a message dialog 
displaying the patient’s service connection and any rated disabilities (Figure 64).

Figure 64: Service Connection and Rated Disabilities Dialog

Step 5. Select the Ordering Section.
Step 6. Select the Associated Clinic.

Note

· A clinic must exist in file #728.44 Clinics and Stop Codes prior to being available 
for selection in any Data Entry options.

· If an Associated Clinic has non-conforming stop codes, the clinic will not be 
selectable.

Step 7. Select the associated diagnosis code for the procedure. 

Note 

· Diagnoses which exist for the same location, procedure date/time, Associated Clinic 
and patient will be retrieved when those key fields are encountered for a new 
procedure. 

· Search for a diagnosis by entering one of the following in the Dx (Diagnosis) Lookup 
box (Figure 65):
o International Classification of Diseases (ICD) code (whole or partial)
o Diagnosis Name (whole or partial)

· Click the Binoculars (Search) button to the right of the Dx Lookup box or press <Enter> 
to begin the search. 

· Select from the resulting dropdown list and click the Add a Dx button to place the 
desired diagnosis in the Diagnoses box. The user can also double-click on a diagnosis to 
add it. 
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Note

· If an ICD code is used to search for a diagnosis, the user can press <Enter> to 
place the diagnosis in the Diagnoses box. 

· Repeat as needed to select and add multiple diagnoses. 
· Values in the Diagnoses box may be removed, or the Primary Diagnosis may be changed, 

by selecting a diagnosis and using the associated buttons to the left of the Diagnoses box. 
The primary diagnosis will always be the first entry in the diagnosis box.  

Figure 65: Multiple Dates/Multiple Procedures, Select Patient Tab, Diagnoses Box 

Step 8. Click the Add Patient button to add this patient to the list of Selected Patients and 
display a blank screen ready for another entry.

Step 9. Use the View Selected Patients tab to check the work.

4.1.3.5 Verify Information Using the View Selected Patients Tab 
The following instructions are used to verify information using the View Selected Patients tab, 
and to delete information for a specific patient.
Note that the number of patients selected by the user is displayed on the tab header.
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Step 1. Click the View Selected Patients tab to review the list of selected patients (Figure 66). 

Figure 66: Multiple Dates/Multiple Procedures View Selected Patients Tab

Step 2. To remove a patient from the list, select a record and click the Delete Patient button. 
Click the Yes button on the Confirmation message dialog (Figure 67). 

Figure 67: Deleting Patient Confirmation Dialog

Step 3. To view a patient in an expanded format, select the record and click the View Details 
button.  

· The patient record is not editable using the View Patient Record Detail screen (Figure 
68).
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Step 4. Click the Close Patient View button to return to the View Selected Patients tab. 

Figure 68: View Patient Record Details Screen 
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4.1.3.6 Verify Information Using the Records Pending Filing Tab 
The Records Pending Filing tab lists the individual records (transactions) that will be processed 
when the OK or Save button at the bottom of the screen is clicked (Figure 69).
Step 1. Click the Records Pending Filing tab to view a list of the records to be filed. 

Note: 

· The number of records pending is displayed on the tab header.
· This screen is not editable.

Figure 69: Multiple Dates/Multiple Procedures Records Pending Filing Tab

Step 2. Click the OK button to return to the Data Entry menu or click Save to add more entries. 

· After clicking the Save button, an information dialog will appear on the screen to show 
the number of records added (Figure 70).

Figure 70: Information Dialog after Saving
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The records consist of every combination of the dates, procedures, and patients selected on the 
tabs described in the preceding sections, and the providers selected will be assigned to each 
record.
Step 3. To change the list of records pending filing, review and revise the selections on the 

Providers, Procedures and Select Patient tabs. as well as the values on the Selected 
Dates/Times list.

Step 4. To correct an entry, return to the Data Entry menu and select Data Entry by Patient.

4.2 Spreadsheet
Data can be batch processed in the Event Capture GUI using the spreadsheet import and upload 
options. Two types of spreadsheets can be used for this data entry — the regular spreadsheet or 
the State Veterans Home spreadsheet. Both methods of import are launched from the 
Spreadsheet Upload screen. Once a spreadsheet is imported into Event Capture, the data can be 
uploaded to VistA.

4.2.1 Import a Regular Spreadsheet
Importing is the traditional method for batch processing spreadsheet data. The spreadsheet 
import functionality works with MS Excel® files, as well as with tab or comma delimited files.
Before the User Starts

· A template with default column order is available to aid in populating spreadsheets prior 
to import. The header row will not be processed when data is imported, and it should 
remain in the spreadsheet during the import process. 

· Any spreadsheets that do not match the column layout of the template will be rejected at 
import. 

· The ECS spreadsheet template is available on the VA Intranet, Program Documents page. 
· Once the template is downloaded, save it to a local hard-drive for later use. 
· Both *.XLS (pre- 2007) and *.XLSX versions of MS Excel spreadsheets are valid for use 

in the Event Capture spreadsheet import process. 



Event Capture System 2.0
User Guide 62 May 2025          

What the User Will See
· After selecting the Spreadsheet option from the main menu, the Spreadsheet Upload 

screen displays a blank grid form (Figure 71).

Figure 71: Spreadsheet Upload Screen Before Import

Steps for importing a regular spreadsheet:
Step 1. Click the Open a Regular Spreadsheet button or select the Open Spreadsheet option 

from the File menu. 

· A standard Select File dialog will display, allowing the user to select the spreadsheet to 
be imported. 

Step 2. Once the desired spreadsheet is selected for import, click the Open button. 

· The data is then imported into Event Capture and will be displayed in the grid of the 
Spreadsheet Upload form (Figure 72).

Figure 72: Imported Spreadsheet Data Shown in the Spreadsheet Upload Form
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4.2.1.1 Regular Spreadsheet Fields 
The regular spreadsheet contains 37 columns. Each is described here: 
Record Num: The Record Num field displays the Record Number, which is a unique number 
used to associate error messages with the correct row of data. If this field is blank, VistA 
validation will not be done. This is a required field.
Location: The Location field displays the station number, and it must exist in the 
INSTITUTION file (#4). This is a required field.
Pat SSN: The Pat SSN is the SSN of the patient for whom the procedure was done. It can 
contain only digits, and must exist in the PATIENT file (#2, ^DPT). If the SSN is shorter than 9 
digits, it will be padded with leading zeros. This is a required field.
Patient LName: The Patient Lname (last name) field is the surname of the patient and must 
contain a value at least two characters in length. Combined with the Patient FName value (in the 
form “last name, first name”), it must match the name in the PATIENT file (#2) for the Patient 
SSN associated with the row in the spreadsheet. This is a required field.
Patient FName: The Patient Fname (first name) field is optional. However, together with the 
Patient LName (in the form “last name, first name”), it must match the name in the PATIENT 
file (#2) for the Patient SSN associated with the row in the spreadsheet.
DSS Unit Name: The DSS Unit Name field indicates the DSS Unit used for the patient 
procedure. The DSS Unit Name is not required if the DSS Unit IEN is filled in. If this field 
contains a value, then it must have a “B” cross-reference on the DSS UNIT file (#724).
DSS Department: Because the DSS Department is not necessarily unique, it is no longer being 
used to identify the DSS Unit. Values entered in this field will be ignored. Use the DSS Unit 
Name or the DSS Unit IEN to identify the DSS Unit.
DSS Unit IEN: The DSS Unit IEN is an alternate way to identify the DSS Unit used for the 
patient procedure. It is not required if the DSS Unit Name is filled in. If the DSS Unit IEN field 
contains a value, that value must exist in the DSS UNIT file (#724).
Proc Code: The Proc Code or CPT code represents the procedure performed for the patient. Any 
National Procedure, Local Procedure, or CPT code is valid for this field provided it exists in the 
EC NATIONAL PROCEDURE file (#725) or the CPT file (#81), and the Event Code Screen 
(comprised of the Location, DSS Unit, and Procedure) is active. This is a required field.
Volume: The Volume field usually indicates the number of procedures performed, but it can also 
be used to track the number of bed days, or the time increments spent performing the procedure. 
For example, if a 15-minute increment represents a unit, a Volume of 1 equals 15 minutes, a 
volume of 2 equals 30 minutes, etc. The volume must be a number from 1 to 99. This is a 
required field.
Ordering Sect: The Ordering Sect field is the name of the medical section which ordered the 
procedure for the patient. If the user enters a value for the Ordering Section, it will be validated 
against the "B" cross reference in the MEDICAL SPECIALTY file (#723). If the user leaves this 
field blank, the program will derive the Ordering Section from DSS UNIT file (#724) based on 
the DSS Unit IEN.
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Enc Date/Time: The Enc Date/Time field is the Date and Time of the encounter. The value can 
be in any valid FileMan format. The 'seconds' are ignored; the month, day, and year can be 
separated by any special character (non-numeric, non-alpha) except '^' and '@'. This field is 
required.

Examples:

mm/dd/yy @hh:mm:ss

mm/dd/yyyy @hh:mm:ss

mm-dd-yy @hh:mm

mmm dd,yyyy @hhmm

mmddyy@hhmm

N, N-1, N-5h, etc.

Category: The Category field provides Event Capture a common level to group associated 
procedures. Multiple procedures can be defined for each category. This field is optional and will 
be assigned a value of ‘0’ if blank. However, if the user enters a value, a “B” cross-reference for 
that value must exist in the EVENT CAPTURE CATEGORY file (#726).
Diag Code: The Diag Code field is the primary Diagnosis Code value. It must exist in the ICD 
DIAGNOSIS file (#80) and be active for the date/time of the encounter.

Note: 

· The Diagnosis Code is only required for records sent to PCE and will be ignored 
otherwise. For DSS units set up as 'OOS', the diagnosis field will be ignored. 

Sec Dx 1: The Sec Dx 1 field is a secondary Diagnosis Code value. It must exist in the ICD 
DIAGNOSIS file (#80) and be active for the date/time of the encounter.

Note: 

· Secondary diagnosis codes are optional. For records NOT sent to PCE (including 
those with DSS set up as 'OOS'), the diagnosis codes will be ignored. 

Sec Dx 2: The Sec Dx 2 field is a secondary Diagnosis Code value. It must exist in the ICD 
DIAGNOSIS file (#80) and be active for the date/time of the encounter.

Note: 

· Secondary diagnosis codes are optional. For records NOT sent to PCE (including 
those with DSS set up as 'OOS'), the diagnosis codes will be ignored. 

Sec Dx 3: The Sec Dx 3 field is a secondary Diagnosis Code value. It must exist in the ICD 
DIAGNOSIS file (#80) and be active for the date/time of the encounter.

Note: 

· Secondary diagnosis codes are optional. For records NOT sent to PCE (including 
those with DSS set up as 'OOS'), the diagnosis codes will be ignored. 
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Sec Dx 4: The Sec Dx 4 field is a secondary Diagnosis Code value. It must exist in the ICD 
DIAGNOSIS file (#80) and be active for the date/time of the encounter.

Note: 

· Secondary diagnosis codes are optional. For records NOT sent to PCE (including 
those with DSS set up as 'OOS'), the diagnosis codes will be ignored. 

Assoc Clin Name: The Assoc Clin Name is the name of the Associated Clinic of the procedure. 
If the DSS Unit is set to send all records to PCE, either an Associated Clinic name or Associated 
Clinic IEN is required. If both are entered, only the IEN will be used to identify the Associated 
Clinic.
Assoc Clin IEN: The Assoc Clin IEN field is the IEN of the Associated Clinic of the procedure. 
If the DSS Unit is set to send all records to PCE, either an Associated Clinic name or Associated 
Clinic IEN is required. If both are entered, only the IEN will be used to identify the Associated 
Clinic.
Mod 1: The Mod 1 field provides additional information about a CPT procedure. Up to 5 unique 
Modifier codes can be entered for a procedure. The Mod 1 field is not required.
Mod 2: The Mod 2 field provides additional information about a CPT procedure. Up to 5 unique 
Modifier codes can be entered for a procedure. The Mod 2 field is not required.
Mod 3: The Mod 3 field provides additional information about a CPT procedure. Up to 5 unique 
Modifier codes can be entered for a procedure. The Mod 3 field is not required.
Mod 4: The Mod 4 field provides additional information about a CPT procedure. Up to 5 unique 
Modifier codes can be entered for a procedure. The Mod 4 field is not required.
Mod 5: The Mod 5 field provides additional information about a CPT procedure. Up to 5 unique 
Modifier codes can be entered for a procedure. The Mod 5 field is not required.
Agent Orange: The Agent Orange field indicates whether the encounter was related to Agent 
Orange exposure (Y) or was not related to Agent Orange exposure (N). When the spreadsheet is 
uploaded to VistA, validity checks will determine if a value is required in this field.
Ion Rad: The Ion Rad field indicates whether the encounter was related to Ionizing Radiation 
exposure (Y) or was not related to Ionizing Radiation exposure (N). When the spreadsheet is 
uploaded to VistA, validity checks will determine if a value is required in this field.
Service Conn: The Service Conn field identifies if the encounter is related to a service 
connected condition and represents whether the patient has Service Connected eligibility (Y) or 
does not have Service Connected eligibility (N). When the spreadsheet is uploaded to VistA, 
validity checks will determine if a value is required in this field
SW Asia: The SW Asia field indicates whether the encounter was related to Southwest Asia 
Conditions (Y) or was not related to Southwest Asia Conditions (N). When the spreadsheet is 
uploaded to VistA, validity checks will determine if a value is required in this field.
Mil Sexual Trauma: The Mil Sexual Trauma field indicates whether the encounter was related 
to Military Sexual Trauma (Y) or was not related to Military Sexual Trauma (N). When the 
spreadsheet is uploaded to VistA, validity checks will determine if a value is required in this 
field.
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Head Neck Cancer: The Head Neck Cancer field indicates whether the encounter was related to 
Head and Neck Cancer (Y) or was not related to Head and Neck Cancer (N). When the 
spreadsheet is uploaded to VistA, validity checks will determine if a value is required in this 
field.
Combat Vet: The Combat Vet field indicates whether the encounter was related to the patient’s 
Combat Veteran status (Y) or was not related to the patient’s Combat Veteran status (N). When 
the spreadsheet is uploaded to VistA, validity checks will determine if a value is required in this 
field.
SHAD: The SHAD field indicates whether the encounter was related to Project Shipboard 
Hazard and Defense (SHAD) (Y) or was not related to Project SHAD (N). When the spreadsheet 
is uploaded to VistA, validity checks will determine if a value is required in this field.
Camp Lejeune: The Camp Lejeune field indicates whether the encounter was related to Camp 
Lejeune exposure (Y) or was not related to Camp Lejeune exposure (N). When the spreadsheet is 
uploaded to VistA, validity checks will determine if a value is required in this field.
Prov 1 Name or IEN: The Prov 1 Name or IEN field displays the primary Provider for the 
patient procedure being added. The name (last name, first name) must exist in the NEW 
PERSON file (#200) and have a "B" cross reference in that file. The Provider must have an 
active Person Class unless the DSS Unit is set to send no records to PCE; in that case, a Non-
Licensed Provider (identified in the "Providers" option on the ECS Management Menu) may be 
entered.

The provider's IEN may be entered instead of the name.
A value is required in the Prov 1 Name or IEN field.

Prov 2 Name or IEN: The Prov 2 Name or IEN field displays the secondary Provider for the 
patient procedure being added. The name (last name, first name) must exist in the NEW 
PERSON file (#200) and have a "B" cross reference in that file. The Provider must have an 
active Person Class unless the DSS Unit is set to send no records to PCE; in that case, a Non-
Licensed Provider (identified in the "Providers" option on the ECS Management Menu) may be 
entered.

The provider's IEN may be entered instead of the name.
The Prov 2 Name or IEN field is optional.

Prov 3 Name or IEN: The Prov 3 Name or IEN field displays the tertiary Provider for the 
patient procedure being added. The name (last name, first name) must exist in the NEW 
PERSON file (#200) and have a "B" cross reference in that file. The Provider must have an 
active Person Class unless the DSS Unit is set to send no records to PCE; in that case, a Non-
Licensed Provider (identified in the "Providers" option on the ECS Management Menu) may be 
entered.

The provider's IEN may be entered instead of the name.
The Prov 3 Name or IEN field is optional.

Prov 4 Name or IEN: The Prov 4 Name or IEN field displays the fourth Provider for the patient 
procedure being added. The name (last name, first name) must exist in the NEW PERSON file 
(#200) and have a "B" cross reference in that file. The Provider must have an active Person Class 
unless the DSS Unit is set to send no records to PCE; in that case, a Non-Licensed Provider 
(identified in the "Providers" option on the ECS Management Menu) may be entered.
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The provider's IEN may be entered instead of the name.
The Prov 4 Name or IEN field is optional.

Prov 5 Name or IEN: The Prov 5 Name or IEN field displays the fifth Provider for the patient 
procedure being added. The name (last name, first name) must exist in the NEW PERSON file 
(#200) and have a "B" cross reference in that file. The Provider must have an active Person Class 
unless the DSS Unit is set to send no records to PCE; in that case, a Non-Licensed Provider 
(identified in the "Providers" option on the ECS Management Menu) may be entered.

The provider's IEN may be entered instead of the name.
The Prov 5 Name or IEN field is optional.

Prov 6 Name or IEN: The Prov 6 Name or IEN field displays the sixth Provider for the patient 
procedure being added. The name (last name, first name) must exist in the NEW PERSON file 
(#200) and have a "B" cross reference in that file. The Provider must have an active Person Class 
unless the DSS Unit is set to send no records to PCE; in that case, a Non-Licensed Provider 
(identified in the "Providers" option on the ECS Management Menu) may be entered.

The provider's IEN may be entered instead of the name.
The Prov 6 Name or IEN field is optional.

Prov 7 Name or IEN: The Prov 7 Name or IEN field displays the seventh Provider for the 
patient procedure being added. The name (last name, first name) must exist in the NEW 
PERSON file (#200) and have a "B" cross reference in that file. The Provider must have an 
active Person Class unless the DSS Unit is set to send no records to PCE; in that case, a Non-
Licensed Provider (identified in the "Providers" option on the ECS Management Menu) may be 
entered.

The provider's IEN may be entered instead of the name.
The Prov 7 Name or IEN field is optional.

4.2.1.2 Edit Cell Data on the Spreadsheet Upload Form
All imported data can be modified in the Spreadsheet Upload form. The information from the 
selected cell is displayed in the Cell Data edit box (located above the grid). The value can be 
changed in either the edit box or the cell itself.
Data in each cell can be cut, copied, or pasted using the edit menu functions (Figure 73). The 
contents of an individual cell can be deleted using either the Cell Data edit box, or by clicking 
twice in the cell to highlight the data and pressing the <Delete> key.

Note:

· Quickly double-clicking within the cell does not select the data within the cell. To 
select data within a cell, click once within the cell, then click again to select the 
cell’s contents. 

To delete an entire record, click once on a cell within the record to be deleted, then press <Ctrl + 
Delete>. Alternatively, the user can select Edit > Delete Row from the menu bar. Rows can be 
inserted using the Edit > Insert Row function on the menu bar.
To delete a column within the Spreadsheet Upload form, select a cell within the column to be 
deleted, then use the Edit > Delete Column function. Columns can also be inserted using the 
Edit > Insert Column function on the menu bar.
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For any accidental or undesired action performed, the user can undo that action by selecting Edit 
> Undo or by pressing <Ctrl + Z>. The undo function can be used multiple times to undo 
multiple actions.

Figure 73: Spreadsheet Upload — Edit Functions

Note:

· Help is available for each column in the spreadsheet. Click any column, and then 
click the Help button .

4.2.1.3 Modify Column Order
When the Spreadsheet Upload form is opened, the column headers are displayed in a default 
order. The user can change the order of the columns if the EC Template is not used.

Step 1. Click the Column Header button , or select the Change Column Headers option 
from the Spreadsheet Options menu.

· The Column Headers form will be displayed (Figure 74).

Figure 74: Column Headers Form
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Step 2. To change the order of the columns, highlight the column heading from the list and click 
either the Move Up or Move Down button. 

· Repeat Step 2 until the column order matches the columns order of the spreadsheet. Click 
the Apply button to save the column order. 

Note:

· The default column header order is as follows: 
1. Record Num
2. Location
3. Pat SSN
4. Pat LName 
5. Pat FName 
6. DSS Unit Name 
7. DSS Department 
8. DSS Unit Internal Entry Number (IEN) 
9. Proc Code 
10. Volume 
11. Ordering Sect 
12. Enc Date/Time 
13. Category 
14. Diag Code 
15. Sec Dx 1 
16. Sec Dx 2
17. Sec Dx 3
18. Sec Dx 4
19. Assoc Clinic Name
20. Assoc Clinic IEN
21. Mod 1
22. Mod 2
23. Mod 3
24. Mod 4
25. Mod 5
26. Agent Orange
27. Ion Rad
28. Service Conn
29. SW Asia
30. Mil Sexual Trauma
31. Head Neck Cancer
32. Combat Vet
33. SHAD
34. Camp Lejeune (Note: As of Patch EC*2*139, this column is a placeholder)
35. Prov 1 Name or IEN
36. Prov 2 Name or IEN
37. Prov 3 Name or IEN
38. Prov 4 Name or IEN
39. Prov 5 Name or IEN
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40. Prov 6 Name or IEN
41. Prov 7 Name or IEN 

4.2.2 Import a State Veterans Home Spreadsheet 
State Veterans Home facilities use Excel spreadsheets for tracking patient occupancy. Event 
Capture can directly import, and upload, the data from these spreadsheets. 
Before the User Starts 

· The State Veterans Home spreadsheet template is available for download from the State 
Veterans Home website. 

· Once the template is downloaded, save it to a local hard-drive for later use. 
· Both *.XLS (pre- 2007) and *.XLSX versions of MS Excel spreadsheets are valid for use 

in the Event Capture spreadsheet import process. 
· The State Veterans Home Name is in the spreadsheet in cell B853. The name starts after 

the second space. All control, “^”, “;” and “:” characters are stripped from the text found 
in the cell. The name is then truncated to 25 characters. 

What the User Will See 
· From the Spreadsheet Upload screen, the user will click the State Home Spreadsheet 

icon  or use the menu to select File > Open State Home Spreadsheet. 
· A Select File Dialog opens, prompting the user to locate and select the appropriate State 

Veterans Home spreadsheet (Figure 75).

Figure 75: Select File Dialog — Open a State Veterans Home Spreadsheet
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Note:

· Multiple months of State Veterans Home data can be stored in a single spreadsheet 
by using tabbed worksheets to represent the various months. Only the worksheet 
that was active when the spreadsheet was last saved will be imported. 

Step 1. Once the desired State Veterans Home spreadsheet is selected for import, click the Open 
button. 

· A screen prompting the user for more information, including Facility Type, Location, 
DSS Unit, Date and Provider(s), is displayed (Figure 76).

Figure 76: Additional Data Form for State Veterans Home Spreadsheet Import

Note:

· All fields must contain data to import a State Veterans Home spreadsheet.
· Click the Cancel button on this screen to abort the import process.

Step 2. Click the OK button on this screen to continue with the import.  
· The data is then imported into Event Capture and will be displayed in the grid of the 

Spreadsheet Upload form. 

4.2.3 Upload Imported Spreadsheet Data
To start the upload process, click the Upload Records button on the toolbar, or select the 
Upload Records to VistA option from the EC Upload menu.
Before the User Starts

· Each record in the imported spreadsheet is validated before being filed in the EVENT 
CAPTURE PATIENT file (#721). 

· Two levels of validation occur: 
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The first level of validation occurs within the Event Capture GUI application. A check 
for required information is performed, and no data transmits to VistA if this level of 
validation fails for any record in the spreadsheet.
The second level of validation occurs on the server side for each record in the 
spreadsheet. Records that pass this level of validation are filed in the EVENT CAPTURE 
PATIENT file (#721); records that fail this level of validation are not filed. Records that 
are filed are removed from the spreadsheet grid, leaving only those records containing 
errors. 
Each of the remaining records in the spreadsheet will have its associated error message(s) 
displayed in the Error Messages box. The errored record(s) can then be edited before 
retransmitting or deleting.

Note:

· To highlight the cell in the grid that most likely caused the error, select an error 
message. This will assist in identifying, and correcting, missing or invalid data. 

What the User Will See
· A progress bar will display indicating what percentage of the upload is complete. 
· Any failures or errors will be reported to the user. 

4.2.3.1 Spreadsheet Upload Errors 
During the upload process, misspelled names, blank spaces, misaligned columns, missing data 
such as answers to service connected questions, duplicate records and others can lead to upload 
errors. These must be cleared before the record(s) will upload. When upload errors occur, a list 
of all errors (Service Connected errors and others) is available for export by clicking the Create 
Error XLS button on the Spreadsheet Upload screen (Figure 77).
The following errors may display while uploading data to VistA via the Spreadsheet option:

· Record Number: When transmitting records, each row in the spreadsheet needs a unique 
record number (i.e., 1, 2, 3, etc.). If this field is blank, VistA validation will not be done. 
o Delphi messages 

· Error getting column with record number
· Record number is a mandatory field

· Location: The location must exist in the INSTITUTION file (#4) (also known as 
^DIC(4,D0,0), where D0 is the location number). During the spreadsheet upload process, 
Locations are identified by their STA6A identifiers. 
o VistA message 

· Location not in Institution file (#4) — Invalid Station Number 

· Pat SSN: The Patient SSN must exist on the PATIENT file (#2) (also known as global 
file ^DPT). If the SSN is shorter than 9 digits, it will be filled with leading zeroes. Do not 
use dashes in the SSN. 
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o VistA messages 
· No SSN x-ref on PATIENT file (#2)
· No SSN entry on PATIENT file (#2)
· No internal entry on PATIENT file (#2) for SSN x-ref
· SSN does not match SSN on PATIENT file (#2)

· Patient LName and Patient FName: The patient’s name (last name, first name) must 
match the name on the PATIENT file (#2) for that SSN. 
o Delphi messages 

· Error getting column with Patient LName
· Patient LName must be at least 2 characters long

o VistA messages 
· Patient last name does not match VistA
· Patient first name does not match VistA

· DSS Unit Name: If this field contains a value, then it must have a “B” cross-reference on 
the DSS UNIT file (#724). The DSS Unit Name is not required if the DSS Unit IEN 
contains a value. 
o VistA message 

· Invalid DSS Unit Name 

· DSS Unit IEN: If this field contains a value, then it must exist on the DSS UNIT file 
(#724). The DSS Unit IEN is not required if the DSS Unit Name contains a value. 
o VistA message 

· Invalid DSS Unit IEN 
· Proc Code: This is the Procedure or the CPT code value (not the description). A National 

Procedure, Local Procedure or CPT code is valid for this column. Either the Procedure 
must exist in the EC NATIONAL PROCEDURE file (#725), or the CPT must exist in the 
CPT file (#81). In addition, the Event Code Screen must be active for the Location, DSS 
Unit IEN, and Procedure/CPT combination. With functionality put in place by the Code 
Set Versioning project, only CPT codes that are active for the date and time of the event 
are processed. 
o VistA messages 

· Procedure or “D” x-ref not on EC NATIONAL PROCEDURE file (#725)
· Procedure invalid for this Location and DSS Unit
· Unable to check for active EC Event Code Screen

· Volume: The volume must be a number from 1 through 99. 
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o Delphi error messages 
· Error getting column with Volume number
· Volume is a mandatory field
· Volume has a limit of 2 digits

o VistA messages 
· Volume must be a number from 1 to 99
· Volume must contain numeric characters only

· Ordering Section: This is the name of the Ordering Section. Validation (against the “B” 
cross-reference in the MEDICAL SPECIALTY file (#723)) occurs for Ordering Section 
values used in the spreadsheet. If this field is blank, the program will derive the Ordering 
Section from the DSS UNIT file (#724) using the DSS Unit IEN. The record will then be 
transmitted to the Event Capture filer program. 
o VistA message 

· Invalid Ordering Section
· Unable to determine Ordering Section

· Prov Name or IEN: This is the Provider’s last and first name as it appears in the “B” 
cross-reference of the NEW PERSON file (#200). If the provider also has a middle 
initial, then it should be included (e.g., ‘ECPROVIDER, SEVEN J’). If the system finds a 
partial match for the name, the application will return the provider information (provider 
name, IEN, specialty, subspecialty, person class), and the user can then determine which 
provider is correct. The Provider Name must have a “B” cross-reference in the NEW 
PERSON file (#200), and the person class must be active. 
o VistA messages 

· Provider has no B x-ref on NEW PERSON file (#200)
· Unable to determine person class
· Provider does not have an active person class

· Enc Date/Time: The Encounter Date/Time can be in any valid FileMan format. 
o Examples 

· mm/dd/yy @hh:mm
· mm/dd/yyyy @hh:mm
· mm-dd-yy @hh:mm
· mmddyy @hhmm
· N, N-1, N-1H, etc.

o VistA message 
· Invalid encounter date/time 

· Category: The Category field can be blank. If the user enters a value, it needs to have a 
“B” cross-reference in the EVENT CAPTURE CATEGORY file (#726). 
o VistA message 

· Category “B” x-ref not on EC Category file (#726) 

· Diag Code: This is the primary Diagnosis Code value. It must exist on the ICD 
DIAGNOSIS file (#80). With functionality put in place by the Code Set Versioning 
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project, only ICD codes that are active for the date and time of the event process are 
valid. The Diagnosis Code is only required for records sent to PCE. The system ignores it 
otherwise.
o VistA messages 

· Diagnosis code is required for this DSS Unit
· Unable to retrieve Diagnosis IEN

· Assoc Clinic: This is the Associated Clinic name. It must have a “B” cross-reference on 
the HOSPITAL LOCATION file (#44), be of type “C” (clinic), and be active for that 
encounter date. The Associated Clinic must have conforming stop codes to be selectable. 
The Associated Clinic is only required for records sent to PCE; otherwise, it will be 
ignored. 
o VistA messages 

· Associated Clinic is required for this DSS Unit
· Assoc Clin “B” x-ref not found on HOSPITAL LOCATION file (#44)
· Assoc Clin not found on HOSPITAL LOCATION file (#44)
· Associated Clinic must be of type "C" (clinic)
· Associated Clinic inactive for this encounter date

· Modifier (1 through 5): This is the Modifier, or Modifiers, associated with the 
procedure. 
o VistA message 

· Modifier is invalid or duplicated for the selected procedure 

4.2.3.2 Service Connected Questions Validation 
The Service Connected (SC) classification data validation and requirements are similar to those 
for records entered using other ECS data entry options. To assist the user in gathering SC 
information, Event Capture generates a spreadsheet of SC-related deficiencies found when 
transmitting the data.
When recording patient data in ECS using the spreadsheet menu and the ECS unit is set to send 
“ALL Records” to Patient Care Encounter (PCE), the SC classification data must also be entered. 
The care being entered into ECS must be identified as being related to the SC condition with the 
value of “Yes” or “No”. The records that are missing the SC data will fail the upload process and 
will be displayed in the Error Messages area at the bottom-left of the Spreadsheet Upload form.
When a row fails validation, a Create Error XLS button will appear above the Error Messages 
box (Figure 77).

Figure 77: Service Connected Error Messages and Create Error XLS Button
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Click the button to generate an Excel spreadsheet, which the user can then save, print, or email to 
help resolve the errors. Service Connected errors are displayed on the “SC data required” tab 
(Figure 78). Any other errors (non-Service Connected errors) are displayed on the “Other errors” 
tab (Figure 79).

Figure 78: Export Errors — SC Data Required

Figure 79: Export Errors — Other Errors

4.2.3.3 Duplicate Record Errors 
If the system detects duplicate records when the spreadsheet uploads, a File Duplicate Record(s) 
checkbox appears on the screen. The duplicate records display in the Error Messages box. 
Checking the File Duplicate Record(s) box and retransmitting the spreadsheet files the duplicate 
records in the EVENT CAPTURE PATIENT file (#721).

Note:

· Duplicate overrides can be disabled (or allowed) for any given DSS Unit.
· If an override is attempted for a DSS Unit where Allow Duplicate Override is set to 

No, the override will not succeed and will produce an error message similar to “The 
DSS Unit Associated with this record does not allow duplicate entries — Record 
NOT filed.”

· The Edit DSS Unit screen can be used by managers to allow or prevent duplicate 
overrides.



Event Capture System 2.0
User Guide 77 May 2025          

If the user-defined threshold of duplicate records is reached, a screen is displayed with the 
options to continue processing the records, change the threshold, or abort the upload (Figure 80).

Figure 80: Duplicate Record Threshold Reached Screen

· Continue: Resets the counter and resumes processing records. 
· Change: Allows the user to change the duplicate record threshold. 

o This threshold can also be altered prior to starting the upload process by selecting 
the Change Duplicate Threshold option from the Spreadsheet Options menu or by 
clicking the Duplicate Threshold button. 

· Abort: Terminates the upload process. 

4.2.4 Upload Completion 
As records are processed, the uploaded rows will be cleared from the data grid, and a progress 
indicator will display the number of rows uploaded and the number of records in error (Figure 
81). When all rows have been uploaded, both the data grid and the Error Messages list will be 
clear of all records.

Figure 81: Spreadsheet Upload Progress Indicator



Event Capture System 2.0
User Guide 78 May 2025          

4.3 Reports
The following subsections describe the reports available within Event Capture. Users can print, 
preview, or export the report data. 

4.3.1 Reports Available to All Users 
Twelve reports are available to all ECS users. ECMGR security key holders have access to 
additional reports as described in Section 4.3.2. Test patient data are excluded from reports 
(except test patient data entered for DSS Units CH103–109).
Before the User Starts
The following reports are available to all users (including ECMGR key holders):

1. DSS Unit Activity Report
2. DSS Unit Workload Report 
3. ECS Records Failing 

Transmission to PCE Report 
4. Event Capture Encounters Report
5. Ordering Section Summary 

Report  
6. Patient Summary Report 

7. PCE Data Summary Report 
8. Possible Late State Home Entries 

Report 
9. Procedure Reasons Report
10. Procedure Summary Report 
11. Procedures by Clinic Report 
12. Provider Summary Report 
13. Provider (1–7) Summary Report 

What the User Will See 
· A list of reports will be available in the Select Report area (Figure 82). 
· The DSS Unit Activity Report will be the default selection, and the corresponding 

selection criteria will display on the right side of the screen.

Figure 82: Reports Available to All Users
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4.3.1.1 DSS Unit Activity Report 
The DSS Unit Activity Report allows the user to print, display, or export all patients for the 
specified location(s) and DSS Unit(s), within a selected date range (Figure 83).

· The report can be sorted by patient, provider, or SSN. 
· If more than one location has been set up, choose one or all locations. 

Step 1. Enter a data range.
Step 2. Select one or all Location(s).
Step 3. Select one or all DSS Unit(s).
Step 4. Choose Sort Method (Patient, Provider, or SSN) for the report.

Note:

· Only the last four digits of the patient’s SSN will appear on the preview of this 
report.

· The column order does not change with Sort Method when exported into Excel.

Step 5. Export, Preview, Print, or Cancel the report. 

Note: 

· When printing, the default printer is the device most recently used. 

Figure 83: DSS Unit Activity Report Selection Criteria 
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The Report Preview output (Figure 84) includes Patient Name, Last four digits of Patient SSN, 
Inpatient/Outpatient Indicator, Procedure Date and Time, Procedure Code, Procedure Name, 
Volume, Primary Diagnosis, Associated Clinic Name, Stop Code, Credit Stop, CHAR4 Code, 
Primary Provider, and Synonym. After previewing the report, the user will have the option to 
export, print or close the report.

Figure 84: Report Preview — DSS Unit Activity Report

The Export output produces the same information for the selected criteria, in Excel format 
(Figure 85).

Figure 85: Export — DSS Unit Activity Report
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4.3.1.2 DSS Unit Workload Report 
The DSS Unit Workload Report displays the number of procedures performed in each of the 
selected DSS Units. Refer to Figure 86 for an example of the report selection screen.

· With functionality put in place by the Code Set Versioning project, CPT codes, five-
character EC National Codes (when applicable), CPT modifiers and their associated 
descriptions are reflective of the date the event occurred. 

Step 1. Enter a date range.
Step 2. Select one or all location(s).
Step 3. Select one or all DSS Unit(s).
Step 4. Export, Preview, Print, or Cancel the report.

Note:

· When printing, the default printer is the device most recently used. 

Figure 86: DSS Unit Workload Report Selection Criteria
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Figure 87 shows the output for the DSS Unit Workload Preview option. If the DSS Unit uses 
categories, it will list the procedures in each category and how many were performed. It will also 
list the total number of procedures for the unit, at the bottom of the unit listing. After previewing 
the report, the user will have the option to export, print or close the report.

Figure 87: Report Preview — DSS Unit Workload Report

The Export option produces the same information for the selected criteria in Excel format 
(Figure 88).

Figure 88: Export — DSS Unit Workload Report
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4.3.1.3 ECS Records Failing Transmission to PCE Report 
The ECS Records Failing Transmission to PCE Report provides a list of encounters and the 
reasons why records were not transmitted to PCE. Refer to Figure 89 for an example of the 
report selection screen.

· Locations, DSS Units, procedures, five-character EC National Codes (when applicable), 
and categories must be defined before using this option. 

Step 1. Select the date range.
Step 2. Select One, Multiple or All Locations
Step 3. Select One, Multiple or All DSS Units
Step 4. Select to Export, Preview, Print, or Cancel the report.

Note:

· When printing, the default printer is the device most recently used. 

 

Figure 89: ECS Records Failing Transmission to PCE Report Selection Criteria
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Figure 90 shows the output for the Preview option of the ECS Records Failing Transmission to 
PCS Report. The Procedure Date/Time, Location, DSS Unit, Patient, Procedure, Category, last 
four digits of the Patient’s SSN, Provider(s) of care and Reasons for transmission failure are 
listed on the report. After previewing the report, the user has the option to export, print or close 
the report.

Figure 90: Report Preview — ECS Records Failing Transmission to PCE Report

The Export option produces the same information for the selected criteria in Excel format 
(Figure 91).

Figure 91: Export — ECS Records Failing Transmission to PCE Report
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4.3.1.4 Event Capture Encounters Report 
This option allows you to print/display/export Event Capture encounter data within a specified 
date range for selected locations and DSS units. Refer to Figure 92 to view the report selection 
screen.

· The report displays and counts the sum of occurrences by patient and DSS Unit during a 
selected date range. It also enables sorting by patient, provider, or clinic. 
o Sorting by Patient (Figure 94) shows the sum of occurrences for the Patient across 

the date range that is selected.
o Sorting by Provider (Figure 95) shows the sum of occurrences for the Provider 

across the date range that is selected.
o Sorting by Clinic (Figure 96) shows the sum of occurrences for the Clinic across the 

date range that is selected.

· The report includes the fields Patient Name, SSN (last 4 digits), Inpatient or Outpatient 
(I/O), Date/Time, Provider #1, DSS Unit and Volume. 

Step 1. Select a date range.
Step 2. Select one or all Locations.
Step 3. Select one, all, or multiple DSS Unit(s).
Step 4. Select Sort Method (Patient, Provider or Clinic).

Figure 92: Event Capture Encounters Report Selection Criteria
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Step 5. Export, Preview, Print, or Cancel the report. 

Note: 

· When printing, the default printer is the device most recently used. 
· Only the last four digits of the patient’s SSN will appear on the preview of this 

report.
A report timeout warning and message dialog are displayed when All Locations, All DSS units, 
or large date ranges are selected (Figure 93).

Figure 93: Event Capture Encounters Report Timeout Warning

The preview output includes the Patient Name, SSN (last 4 digits), Inpatient or Outpatient (I/O), 
Date/Time, Provider #1, DSS Unit, Volume, Clinic, Stop Code, Credit Stop Code, CHAR4 Code 
and MCA Labor Code. 
The appearance of the report will vary slightly depending on the sort method selected (see Figure 
94, Figure 95 and Figure 96). 

Figure 94: Report Preview — Event Capture Encounters Report Sorted by Patient
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Figure 95: Report Preview — Event Capture Encounters Report Sorted by Provider

Figure 96: Report Preview — Event Capture Encounters Report Sorted by Clinic
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Note:

· The Export option produces the same information for the selected criteria in Excel 
format (Figure 97).

· The column order does not change with Sort Method when exported into Excel

Figure 97: Export — Event Capture Encounters Report

4.3.1.5 Ordering Section Summary Report 
The Ordering Section Summary Report allows the user to print/display procedures ordered 
within a specified date range for a selected ordering section. Refer to Figure 98 for an example of 
the report selection screen.

· The design of this report is for a 132-column format. 
· With functionality put in place by the Code Set Versioning project, CPT codes, five-

character EC National Codes (when applicable), CPT modifiers and their associated 
descriptions are reflective of the date the event occurred. 

· After previewing the report, the user will have the option to export, print or close the 
report. 

Step 1. Enter a date range.
Step 2. Select an Ordering Section.
Step 3. Select a specific or all Location(s).
Step 4. Select one, multiple, or all DSS Unit(s).
Step 5. Export, Preview, Print, or Cancel the report.

Note:

· When printing, the default printer is the device most recently used. 
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Figure 98: Ordering Section Summary Report Selection Criteria

Figure 99 is an image of the Ordering Section Summary Report from Preview.

Figure 99: Report Preview — Ordering Section Summary Report
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The Export option produces the information for the selected criteria in Excel format (Figure 
100).

Figure 100: Export — Ordering Section Summary Report

4.3.1.6 Patient Summary Report 
The Patient Summary Report allows the user to print/display procedure-related data within a 
specified date range for a selected patient. Refer to Figure 101 to view the report selection 
screen.

· The design of this report is for a 132-column format. 
· With functionality put in place by the Code Set Versioning project, CPT codes, five-

character EC National Codes (when applicable), CPT modifiers and their associated 
descriptions are reflective of the date the event occurred. 

· The user can choose to include Procedure Reasons (EVENT CAPTURE PATIENT file 
(#721)) on the report. Up to three reasons will be included. 

· The “Display Reasons on this report” option will clear when the user selects another 
report or upon exiting the screen. 

· After previewing the report, the user will have the option to export, print or close the 
report (Figure 102).

Step 1. Enter a date range.
Step 2. Use the Patient Identifier field to select a patient.

· Enter one of the following: 
o Patient Name (whole or partial, last name first)
o Social Security Number
o Last four digits of the Patient Social Security Number
o First character of Last Name plus the last four digits of the SSN with no spaces

· Press <Enter> on the keyboard or click the Binoculars (Search) button.  
· Choose from the list of patients displayed. 

Step 3. Click the Display Reasons on this report checkbox to include Procedure Reasons in the 
report (Figure 104).

Step 4. Export, Preview, Print, or Cancel the report.
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Note:

· When printing, the default printer is the device most recently used. 
 

Figure 101: Patient Summary Report (without Reasons) — Selection Criteria

Figure 102: Patient Summary Report (without Reasons) — Report Preview
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The Export option produces the information for the selected criteria in Excel format (Figure 
103).

Figure 103: Patient Summary Report (without Reasons) — Export

  

Figure 105 and Figure 106 show examples of this report when the “Display Reasons on this 
report” option is selected on the report criteria screen (Figure 104). 

Figure 104: Patient Summary Report (with Reasons) — Selection Criteria
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Figure 105: Patient Summary Report (with Reasons) — Report Preview

The Export option produces the information for the selected criteria in Excel format (Figure 
106).

Figure 106: Patient Summary Report (with Reasons) — Export
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4.3.1.7 PCE Data Summary Report 
The PCE Data Summary Report allows the user to print/display procedure data that was sent to 
the PCE software for a selected patient within a specified date range. Refer to Figure 107 to view 
the report selection screen.

· The design of this report is for a 132-column format. 
· With functionality put in place by the Code Set Versioning project, CPT codes, five-

character EC National Codes (when applicable), CPT modifiers, diagnosis codes and 
their associated descriptions are reflective of the date the event occurred. 

Step 1. Enter a date range.
Step 2. Use the Patient Identifier field to select a patient.

· Enter one of the following: 
o Patient Name (whole or partial, last name first)
o Social Security Number
o Last four digits of the Patient Social Security Number
o First character of Last Name plus the last four digits of the SSN with no spaces

· Press <Enter> on the keyboard or click the Binoculars (Search) button.  
· Choose from the list of patients displayed. 

Step 3. Export, Preview, Print, or Cancel the report. 

Figure 107: PCE Data Summary Report Selection Criteria 
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The Preview option output includes Patient Name, Date Range, Date/Time of procedure, 
Procedure Name (as sent to PCE), Volume, Provider, Location, Associated Clinic, Stop Code, 
Credit Stop Code, CHAR4 Code, MCA Labor Code, CPT Code, ICD-10 code and Modifier(s) 
(Figure 108). After previewing the report, the user has the option to export, print or close the 
report.

Note:

· When printing, the default printer is the device most recently used. 

Figure 108: Report Preview — PCE Data Summary Report

The Export option produces the information for the selected criteria in Excel format (Figure 
109).

Figure 109: Export — PCE Data Summary Report
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4.3.1.8 Possible Late State Home Entries Report 
The Possible Late State Home Entries Report lists all possible late State Veterans Home entries 
for the selected date range. These are State Veterans Home records that were entered for prior 
months that could be included in a previously completed ECS Extract. Refer to Figure 110 for an 
example of the report selection screen.

Note:

· Late State Home entry reporting is limited to the current fiscal year. Late State 
Home records for previous fiscal years are not processed and will not be included 
on this report. 

Step 1. Select a date range.
Step 2. Export, Preview, Print, or Cancel the report.

Note:

· When printing, the default printer is the device most recently used. 

Figure 110: Possible Late State Home Entries Report Selection Criteria
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The preview output includes the DSS Unit, Location, Patient Name, last 4 digits of SSN (full on 
export), Procedure Date/Time, Entered Date/Time, Entered By (export only), Procedure, Volume 
and Primary Provider. After previewing the report, the user will have the option to export, print 
or close the report.

Figure 111: Report Preview — Possible Late State Home Entries Report

The Export option produces the information for the selected criteria in Excel format (Figure 
112).

Figure 112: Export — Possible Late State Home Entries Report
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4.3.1.9 Procedure Reasons Report 
The Procedures Reasons Report lists the reasons entered for Event Capture Procedures. Refer to 
Figure 113 for an example of the report selection screen.

Note:

· Locations, DSS Units, procedures, and procedure reasons must be defined before 
using this option.

· With functionality put in place by the Code Set Versioning project, CPT codes, 
five-character EC National Codes (when applicable), CPT modifiers, diagnosis 
codes and their associated descriptions are reflective of the date the event occurred.

Step 1. Select a date range.
Step 2. Select one, all, or multiple Location(s).
Step 3. Select one, all, or multiple Procedure Reasons.
Step 4. Select one, all, or multiple DSS Unit(s).
Step 5. Export, Preview, Print, or Cancel the report.

Figure 113: Procedure Reasons Report Selection Criteria
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The report preview output includes the Location, DSS Unit, Procedure Reason, the number of 
times the reason was used, Procedure Code, Procedure Name, Patient Name, last four digits of 
Patient SSN, Provider Name, and Date and Time of the procedure (Figure 114). After 
previewing the report, the user has the option to export, print or close the report.

Note:

· When printing, the default printer is the device most recently used. 

Figure 114: Report Preview — Procedure Reasons Report

This report is exportable into an Excel spreadsheet. The tab in Excel is titled “Reasons” followed 
by the Date Range the user selected (Figure 115).

Figure 115: Export — Procedure Reasons Report
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4.3.1.10 Procedure Summary Report 
The Procedure Summary Report lists the patients seen for a selected Procedure with one or all 
Providers within a defined date range for selected Locations and DSS Units.
The selection criteria include Date Range, Provider(s), Location(s), DSS Unit(s), and Procedure. 
Refer to Figure 116 for an example of the report selection screen. 

Step 1. Enter a date range. 
Step 2. Select one or all Provider(s)
Step 3. Select one, all, or multiple Location(s)
Step 4. Select one, all, or multiple DSS Unit(s)
Step 5. Select a Procedure
Step 6. Export, Preview, Print, or Cancel the report

Note:

· When printing, the default printer is the device most recently used. 

Figure 116: Procedure Summary Report Selection Criteria
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The Preview output (Figure 117) includes the following:
The report header - Displayed at the top of the report. If a single DSS Unit is selected, the 
header will only be shown once. If multiple DSS Units or <ALL> DSS Units are selected, the 
header will be displayed every time records for a new DSS Unit are processed.
The report sub-header - Every time a new Location/DSS Unit combination is encountered, 
lines denoting the Location and DSS Unit are displayed.
Detail lines: 

· Column header for the first detail line is “Category”. 
· Column headers for the second detail line are “CPT Code”, ”Proc Code”, “Procedure 

Name”, “# UNIQUES” and “Volume*”. 
· Column header for the third detail line is “CPT Modifier (Volume)”. 

Subtotal/Total lines:
· The “Totals for [PROVIDER]” line is displayed when a provider changes. This line 

displays the total number of unique patients seen by the provider for the selected 
procedure, and the total number of times the selected procedure was performed by the 
provider. 

· The “Grand Totals for [DSS UNIT]” line is displayed when a DSS Unit changes. This 
line displays the Grand Total of unique patients seen for a selected procedure, as well as 
the Grand Total of times the selected procedure was completed for the DSS Unit. 

Note:

· On the Grand Totals, the # UNIQUES is not always the sum of all # UNIQUES 
since each patient is only counted once for the selected procedure regardless of the 
number of times a patient is seen by other providers.

· If no records exist for the selected criteria, the following message is displayed to the 
user:  “No data to report for the date range selected”. 
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Figure 117: Preview — Procedure Summary Report

The Export option produces the information for the selected criteria in Excel format (Figure 118)

Figure 118: Export — Procedure Summary Report
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4.3.1.11 Procedures by Clinic Report 
The Procedures by Clinic Report allows the user to print, preview, or export procedures used by 
a selected clinic.  
The selection criteria include Date Range, Sort Method, Location, Clinic, and DSS Unit(s). Refer 
to Figure 119 for an example of the report selection screen. 

Step 1. Enter a date range.
Step 2. Select Sort Method of Date or Patient.
Step 3. Select a Location.
Step 4. Select a Clinic.
Step 5. Select one, multiple, or all DSS Units.
Step 6. Export, Preview, Print, or Cancel the report.

Figure 119: Procedures by Clinic Report
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The report preview (Figure 120) separates the output by DSS Unit. Each DSS Unit displays the 
Patient, SSN, Procedure Date/Time, Procedure Code, Procedure Name, Procedure Volume, and 
Provider.

Figure 120: Preview — Procedures by Clinic Report

The exportable version of the “Procedures by Clinic Report” displays the Location, DSS Unit 
(IEN #), Clinic, Patient, SSN, Date of Procedure, Procedure Code, Procedure Name, Volume, 
and Provider Name (Figure 121).

Figure 121: Export — Procedures by Clinic Report
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4.3.1.12 Provider Summary Report 
The Provider Summary Report allows the user to print, preview, or export the number of 
procedures performed for one or all locations and one or all DSS Units within a specified date 
range. Within each DSS Unit for each location, the report is sorted by provider, category (if the 
DSS Unit is defined to sort procedures by category), and procedures (listed alphabetically). Refer 
to Figure 122 for an example of the report selection screen.

Note:

· Locations, DSS Units, categories, procedures, and procedure reasons must be 
defined before generating this report.

· The design of this report is for a 132-column format.
· With functionality put in place by the Code Set Versioning project, CPT codes, 

five-character EC National Codes (when applicable), CPT modifiers and their 
associated descriptions are reflective of the date the event occurred.

Step 1. Enter a date range.
Step 2. Select one or all Location(s).
Step 3. Select one or all DSS Unit(s).
Step 4. Export, Preview, Print, or Cancel the report.

Note:

· When printing, the default printer is the device most recently used. 

Figure 122: Provider Summary Report Selection Criteria
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The preview option output includes Location, DSS Unit, Provider, Category (if applicable), CPT 
Code, Procedure Code, Procedure Name, Procedure Reason, Volume, Modifier(s), and Total 
number of procedures performed by the provider within the specified date range (Figure 123).

Note:

· If Procedure Reason #1 is not listed, the report prints “Reason Not Defined”. 

Figure 123: Preview — Provider Summary Report

The Export option produces the information for the selected criteria in Excel format (Figure 
124).

Figure 124: Export — Provider Summary Report
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4.3.1.13 Provider (1–7) Summary Report 
The Provider (1–7) Summary Report summarizes the workload of providers for a selected date 
showing how many times a specific procedure was performed on a patient with the selected 
provider. This report provides the ability to view up to seven provider numbers for providers 
within a Location/DSS Unit. Refer to Figure 125 to view the report selection screen.

Note:

· The design of this report is for a 132-column format.
· With functionality put in place by the Code Set Versioning project, CPT codes, 

five-character EC National Codes (when applicable), CPT modifiers and their 
associated descriptions are reflective of the date the event occurred.

Step 1. Enter a date range.
Step 2. Enter the name of a Provider.
Step 3. Select one, all or multiple Location(s).
Step 4. Select one, all, or multiple DSS Unit(s).
Step 5. Export, Preview, Print, or Cancel the report.

Note:

· When printing, the default printer is the device most recently used. 

Figure 125: Provider (1–7) Summary Report Selection Criteria
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The Preview option output includes Procedure Code, Procedure Name, Patient Name, Last four 
digits of patient SSN, a matrix showing how many times a specific procedure was performed on 
a specific patient with the selected provider as Provider 1, Provider 2, to Provider 7, Modifier(s), 
Subtotals by procedure, and Grand Total of procedures (Figure 126) After previewing the report, 
the user has the option to export, print or close the report.

Figure 126: Preview — Provider (1–7) Summary Report

The Export option produces the information for the selected criteria in Excel format (Figure 
127).

Figure 127: Export — Provider (1–7) Summary Report
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4.3.2 Reports Available to ECMGR Key Holders Only
The following reports are available only to ECMGR key holders:

1. Category Report
2. Disabled Category and Procedure Summary 
3. DSS Units with any Associated Stop Code Errors  
4. DSS Units/Event Code Screens for Selected Procedure Code Report 
5. DSS Unit User Access Report 
6. Event Capture Edit Log Report
7. Event Code Screens with CPT Codes Report
8. Event Code Screens with Inactive Default Associated Clinic
9. Inactive Person Class Report (IPC)
10. National / Local Procedure Codes with Inactive CPT Codes
11. National / Local Procedure Report
12. Print Category and Procedure Summary (Report)
13. Send No Records DSS Units Report

ECMGR reports are displayed in the Select Report area, below the asterisk line (Figure 128).

Figure 128: Report Selection Screen for ECMGR Key Holders
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4.3.2.1 Category Report 
The Category Report allows Management users to print, preview, or export the established local 
categories. This report can be generated for active categories, inactive categories, or all 
categories. For inactive categories, the inactive date is included in the output. Refer to Figure 129
for an example of the report selection screen.

Note:

· Use the Category — Add or Update Categories option to create categories before 
selecting this report. 

Step 1. Select the report.
Step 2. Choose a status of Active, Inactive, or Both.
Step 3. Export, Preview, Print, or Cancel the report.

Note:

· When printing, the default printer is the device most recently used. 

Figure 129: Category Report Selection Criteria
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Selecting Active and then Preview produces output showing the list of active categories (Figure 
130). After previewing the report, the user has the option to export, print or close the report.

Figure 130: Report Preview — Category Report (Active)

The Export option produces the information for the selected criteria in Excel format (Figure 
131).

Figure 131: Export — Category Report (Active)
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Selecting Inactive and then Preview produces output that displays inactive categories (Figure 
132).

Figure 132: Report Preview — Category Report (Inactive)

The Export option produces the information for the selected criteria in Excel format (Figure 
133).

Figure 133: Export — Category Report (Inactive)
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Selecting Both and then Preview produces output that displays both active and inactive 
categories (Figure 134).

Figure 134: Report Preview — Category Report (Both Active and Inactive)

The Export option produces the information for the selected criteria in Excel format (Figure 
135).

Figure 135: Export — Category Report (Both Active and Inactive)
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4.3.2.2 Disabled Category and Procedure Summary  
This report allows Management users to print, preview, or export the ECS categories that have 
been disabled for one or all DSS Units within a specified location. Event Code Screens that are 
comprised of DSS Units that allow category use and have Event Code Screens defined using the 
disabled category will appear on this report. Refer to Figure 136 for an example of the report 
selection screen.
Step 1. Select the report.
Step 2. Select one, all, or multiple Location(s).
Step 3. Export, Preview, Print, or Cancel the report.

Note:

· When printing, the default printer is the device most recently used. 

Figure 136: Disabled Category and Procedure Summary Report Selection Criteria
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The report preview output includes the Run Date, Location, Service, DSS Unit Name and IEN, 
Send Status, and DSS Dept. For each disabled procedure, the report also includes Procedure 
Code, Procedure Name, Synonym, Clinic IEN, Clinic, Stop Code, Credit Stop Code, CHAR4 
Code and MCA Labor Code (Figure 137). After previewing the report, the user has the option to 
export, print or close the report.

Figure 137: Report Preview — Disabled Category and Procedure Summary

The Export option produces the information for the selected criteria in Excel format (Figure 
138). The exported output includes EC Screen Status, Location, Service, DSS Unit, DSS Unit 
IEN, DSS Dept., Send Status, DSS Unit Inactive, Disabled Category, CPT Code, Procedure 
Code, Procedure Name, Synonym, Clinic IEN, Clinic, Clinic Stop Code, Credit Stop Code, 
CHAR4 Code and MCA Labor Code.

Figure 138: Export — Disabled Category and Procedure Summary
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4.3.2.3 DSS Units with any Associated Stop Code Errors Report 
The Event Capture software restricts DSS-only workload to using valid Stop Codes. This report 
provides Management users a list of DSS Units with any error with the Associated Stop Code. 
Refer to Figure 139 for an example of the report selection screen.

Note:

· To assist sites in locating DSS Units that have invalid associated Stop Codes, the 
DSS Unit list with Secondary Associated Stop Codes is provided. This may be 
attached as a secondary menu option and run as often as needed. The only prompt is 
for Device.

· Select an active, non-secondary Stop Code to replace the Stop Code in the DSS 
Unit set up.

Step 1. Select the report.
Step 2. Export, Preview, Print, or Cancel the report.

Note:

· When printing, the default printer is the device most recently used. 

Figure 139: DSS Units with Any Associated Stop Code Errors Selection Criteria
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The report preview produces output that includes the DSS Unit IEN and name, Associated Stop 
Code IEN and name, and the reason for the error (Figure 140). After previewing the report, the 
user has the option to export, print or close the report.

Figure 140: Report Preview — DSS Units with Any Associated Stop Code Errors

The Export option produces the information in Excel format (Figure 141).

Figure 141: Export — DSS Units with Any Associated Stop Code Errors
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4.3.2.4 DSS Units/Event Code Screens for Selected Procedure Code Report 
The DSS Units/Event Code (EC) Screens for Selected Procedure Code Report allows 
Management users to print, preview, or export DSS unit and EC screen data for a selected 
procedure code and specified locations. Refer to Figure 142 for an example of the report 
selection screen.

Note:

· The design of this report is for a 132-column format. 

Step 1. Select the report.
Step 2. Select one, all, or multiple Location(s).
Step 3. Select a Procedure.
Step 4. Export, Preview, Print, or Cancel the report.

Note:

· When printing, the default printer is the device most recently used. 

Figure 142: DSS Units/Event Code Screens for Selected Procedure Code Report Selection Criteria
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Figure 143: Report Preview — DSS Units/Event Code (EC) Screens for Selected Procedure Code 
Report

This report is exportable into an Excel spreadsheet (Figure 144). The tab in Excel is titled 
“Selected Procedure Code”.

Figure 144: Export — DSS Units/Event Code (EC) Screens for Selected Procedure Code Report
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4.3.2.5 DSS Unit User Access Report 
The DSS Unit User Access Report allows Management users to print, preview, or export 
information regarding user with access to DSS unit data for specified locations and DSS units. 
Refer to Figure 145 for an example of the report selection screen.

Note:

· Similar information is available using the Management Menu > Access by User 
option (Refer to Section 4.4.3, Grant Access to DSS Units by User). 

Step 1. Select the report.
Step 2. Select one or all Location(s).
Step 3. Select one, all, or multiple DSS Units.
Step 4. Export, Preview, Print, or Cancel the report.

Note:

· When printing, the default printer is the device most recently used. 

Figure 145: DSS Unit User Access Report Selection Criteria
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The report preview produces output that includes DSS Unit Name, User Name, User IEN (from 
the New Person (#200) file), and Person Class/Classification (Figure 146). After previewing the 
report, the user has the option to export, print or close the report.

Figure 146: Report Preview — DSS Unit User Access Report

This report is exportable into an Excel spreadsheet (Figure 147). The tab in Excel is titled “DSS 
Unit User Access Report” and includes the information for the selected criteria.

Figure 147: Export — DSS Unit User Access Report
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4.3.2.6 Event Capture Edit Log Report 
This report displays the Entered or Edited by Staff Name field, in addition to the Location, DSS 
Unit, Procedure, Date of Procedure, Patient Name, last 4 digits of Patient SSN and Provider 
Name.
The selection criteria include Date Range, Sort Method, Location, and DSS Unit(s). Refer to 
Figure 148 for an example of the report selection screen.

Step 1. Select Date Range.
Step 2. Select Sort Method: Procedure Date or Staff Member.
Step 3. Select Location.
Step 4. Select One, Multiple, or All DSS Units.
Step 5. Export, Preview, Print, or Cancel the report.

Figure 148: Event Capture Edit Log Report Selection Criteria
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The Event Capture Edit Log Report output (Figure 149) is separated by DSS Unit and displays 
the Patient, last 4 digits of SSN, Procedure, Date of Procedure, Provider Name, and 
Entered/Edited by Staff Name fields.

Figure 149: Preview — Event Capture Edit Log Report

The exportable version of the Event Capture Edit Log Report (Figure 150) displays the Location, 
DSS Unit (IEN#), Patient, entire SSN, Procedure, Date of Procedure, Provider Name, and 
Entered or Edited by Staff Name fields.

Figure 150: Export – Event Capture Edit Log Report
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4.3.2.7 Event Code Screens with CPT Codes Report 
This option allows holders of the ECMGR key to print, preview, or export Event Code Screens 
with active and/or inactive CPT codes for one or all specific DSS Unit(s). Refer to Figure 151 for 
an example of the report selection screen.
Step 1. Select the report.
Step 2. Select One or all Location(s).
Step 3. Select one or all DSS Unit(s).

Note:

· If “All” is selected for the DSS Unit, the Category will also be set to “All” and will 
be disabled. 

Step 4. Select a Category. 

Note:   

· Categories only appear if the Event Code Screen uses categories to group 
procedures. 

Step 5. Select Active, Inactive, or Both (Active and Inactive) CPT Codes.
Step 6. Export, Preview, Print, or Cancel the report.

Note:

· When printing, the default printer is the device most recently used. 

Figure 151: Event Code Screens with CPT Codes Report Selection Criteria
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The report preview output includes Run Date and Time, Location, DSS Unit, Category, 
Procedure Name, National Number, CPT Code, Synonym, Associated Clinic, Stop Code, Credit 
Stop, CHAR4 Code and MCA Labor Code (Figure 152). After previewing the report, the user 
has the option to export, print or close the report.

Note:

· Inactive CPT codes are flagged with an *I* when printing both active and inactive 
codes.

· Category, Synonym, Associated Clinic and MCA Labor Code are included only 
when data is available for those items.

Figure 152: Preview — Event Code Screens with CPT Codes Report 
(Both Active and Inactive CPT Codes Selected)

This report is exportable into an Excel spreadsheet. The tab of the exported report indicates 
whether the report shows only active, only inactive, or both active and inactive CPT codes 
(Figure 153). When exporting the report, all Inactive CPT codes are flagged with an 
**Inactive** indicator.

Figure 153: Event Code Screens with CPT Codes Report from Export
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4.3.2.8 Event Code Screens with Inactive Default Associated Clinic 
The Event Code Screens with Inactive Default Associated Clinic report allows Management 
users to print, preview, or export inactive default associated clinic data for specified locations 
and DSS units. Refer to Figure 154 for an example of the report selection screen.
Step 1. Select the report.
Step 2. Select one, all, or multiple Location(s).
Step 3. Select one, all, or multiple DSS Unit(s).
Step 4. Export, Preview, Print, or Cancel the report.

Note:

· When printing, the default printer is the device most recently used. 

Figure 154: Event Code Screens with Inactive Default Associated Clinic Selection Criteria
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The report preview output includes DSS Unit Name, Location, Category, Procedure Code, Clinic 
IEN, and Clinic Name (Figure 155). After previewing the report, the user has the option to 
export, print or close the report.

Figure 155: Preview — Event Code Screens with Inactive Default Associated Clinic

The Export option produces the information for the selected criteria in Excel format (Figure 
156).

Figure 156: Export — Event Code Screens with Inactive Default Associated Clinic
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4.3.2.9 Inactive Person Class Report (IPC) 
The Inactive Person Class Report (IPC) allows Management users to identify providers who do 
not have an assigned person class or an active person class in the NEW PERSON file (#200) for 
the date of the procedure. Refer to Figure 157 for an example of the report selection screen.
Step 1. Select the report.
Step 2. Enter a date range.
Step 3. Select Sort by Patient or Sort by Procedure.
Step 4. Export, Preview, Print, or Cancel the report.

Note:

· When printing, the default printer is the device most recently used. 

Figure 157: Inactive Person Class Report Selection Criteria
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The report preview output displays the Patient Name, SSN (last four), Date of Procedure, 
Provider, and any Errors (Figure 158). After previewing the report, the user has the option to 
export, print or close the report.

Figure 158: Preview — Inactive Person Class Report

The Export option produces the information for the selected criteria in Excel format (Figure 
159).

Note:

· The column order does not change with Sort Order when exported into Excel. 

Figure 159: Export — Inactive Person Class Report
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4.3.2.10 National/Local Procedure Codes with Inactive CPT Codes 
This report allows Management users to see a list of National and Local Procedure Codes with 
inactive CPT codes from the EC NATIONAL PROCEDURE file (#725). Refer to Figure 160 for 
an example of the report selection screen.

Step 1. Select the report.
Step 2. Select the Preferred Report (National, Local, or Both)
Step 3. Select the Sort Method (Procedure Name, Procedure Number, CPT Code, or CPT Inactive 

Date)
Step 4. Select the Sort Order (Ascending or Descending)
Step 5. Export, Preview, Print, or Cancel the report. 

Note:

· When printing, the default printer is the device most recently used. 

Figure 160: National/Local Procedure Codes with Inactive CPT Codes Selection Criteria
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The report preview header displays the user’s selected criteria (preferred report type and sort 
method), as well as the run date. The content of the report includes the Procedure Number, 
Procedure Name, CPT Code, and the Inactive Date (Figure 161). After previewing the report, the 
user has the option to export, print or close the report.

Figure 161: Report Preview — National/Local Procedure Codes with Inactive CPT Codes Report

The Export option produces the information for the selected criteria in Excel format (Figure 
162).

Figure 162: Export — National/Local Procedure Codes with Inactive CPT Codes Report
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4.3.2.11 National/Local Procedure Report — Active Procedures 
The National/Local Procedures Report allows Management users to display a listing of Event 
Capture active or inactive procedures (See section 4.3.2.12  for an overview of the report for 
Inactive Procedures). Refer to Figure 163 to view the report selection screen.

Note:

· Use the Procedure — Add or Update Local Procedures option to create local 
procedures before using this option. 

Step 1. Select the report.
Step 2. Choose Active.
Step 3. Choose a Preferred Report (National, Local, or Both).
Step 4. Choose the Sort Method (Procedure Name or Procedure Number).
Step 5. Export, Preview, Print, or Cancel the report.

Note:

· When printing, the default printer is the device most recently used. 

Figure 163: National/Local Procedure Report (Active) Selection Criteria
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For active procedures, the report preview output includes the user’s selected criteria (report type 
and sort method) in the header information. The report content includes the Procedure Name, 
Procedure Number, and CPT (Figure 164). After previewing the report, the user has the option to 
export, print or close the report.

Figure 164: Report Preview — National/Local Procedure Report (Active)

The Export option produces the information for the selected criteria in Excel format (Figure 
165).

Figure 165: Export — National/Local Procedure Report (Active)
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4.3.2.12 National/Local Procedure Report — Inactive Procedures 
The National/Local Procedures Report allows Management users to display a listing of Event 
Capture active or inactive procedures (See section 4.3.2.11 for an overview of the report for 
Active Procedures). Refer to Figure 166 to view the report selection screen.

Note:

· Use the Procedure — Add or Update Local Procedures option to create local 
procedures before using this option. 

Step 1. Select the report.
Step 2. Select Active or Inactive.

Note:  

· Selecting the Inactive radio button disables the Preferred Report and Sort Method 
options. 

Step 3. Export, Preview, Print, or Cancel the report. 

Note: 

· When printing, the default printer is the device most recently used. 

Figure 166: National/Local Procedure Report (Inactive) Selection Criteria 
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For inactive procedures, the report preview output includes Procedure Name, Procedure Number, 
CPT, and the Inactive Date (Figure 167). After previewing the report, the user has the option to 
export, print or close the report.

Figure 167: Preview — National/Local Procedure Report (Inactive)

The Export option produces the information for the selected criteria in Excel format (Figure 
168).

Figure 168: Export — National/Local Procedure Report (Inactive)
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4.3.2.13 Print Category and Procedure Summary (Report) 
The Print Category and Procedure Summary Report allows Management users to print, display, 
and export the Event Code Screens for one or all DSS Units within a specified location. 
Locations, DSS Units, local categories, and procedures must be defined before using this option. 
Refer to Figure 169 for an example of the report selection screen.

Note:

· Use the DSS Unit — Add or Update DSS Units option to create DSS Units 
categories before using this option.

· Use the Category — Add or Update Categories option to create categories before 
using this option.

· Use the Procedure — Add or Update Local Procedures option to create procedures 
before using this option.

Step 1. Select one or all Location(s).
Step 2. Select Active, Inactive or Both (Active and Inactive) DSS Units.
Step 3. Select one, all, or multiple DSS Unit(s).
Step 4. Select Active, Inactive or Both (Active and Inactive) Event Code Screens.
Step 5. Export, Preview, Print or Cancel the report

Note:

· When printing, the default printer is the device most recently used. 

Figure 169: Print Category and Procedure Summary (Report) Selection Criteria
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The report preview output includes Run Date, Location, Service, DSS Unit, Send Status, DSS 
Dept., Category (if applicable), Procedure Code, Procedure Name, Synonym, Associated Clinic 
IEN (if applicable), Associated Clinic (if applicable), Stop Code, Credit Stop Code, CHAR4 
Code and MCA Labor Code (Figure 170). After previewing the report, the user has the option to 
export, print or close the report.

Figure 170: Report Preview — Print Category and Procedure Summary (Report)

The Export option produces the information for the selected criteria in Excel format (Figure 
171).

Figure 171: Export — Print Category and Procedure Summary (Report)
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4.3.2.14 Send No Records DSS Units Report 
The Send No Records DSS Units Report provides Management users with a list of active DSS 
Units with send to PCE status of Send NO RECORDS. Refer to Figure 172 to view the report 
selection screen.
Step 1. Select the report.
Step 2. Export, Preview, Print, or Cancel the report.

Note:

· When printing, the default printer is the device most recently used. 

Figure 172: Send No Records DSS Units Report Required Fields



Event Capture System 2.0
User Guide 139 May 2025          

The report preview output includes DSS Unit Name and IEN, Associated Stop Code [and Credit 
Stop and CHAR4 Code if present] (Figure 173). After previewing the report, the user has the 
option to export, print or close the report.

Figure 173: Report Preview — Send No Records DSS Units Report

The Export option produces the information for the selected criteria in Excel format (Figure 
174).

Figure 174: Export — Send No Records DSS Units Report
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4.4 Management Menu 
The Management Menu is available to users with the ECMGR security key. This option accesses 
the menus needed for management of the Event Capture software. The main menu in the 
Management Menu provides the following management functions (Figure 175):

· Location — Update Location Information
· DSS Unit — Add or Update DSS Units
· Access by User — Grant Access to DSS Units by User
· Category — Add or Update Categories
· Procedure — Add or Update Local Procedures
· Reason — Add or Update Procedure Reasons
· Event Code Screen — Add, Update or Copy Event Code Screens
· Inactivate EC Screen — Identify/Inactivate Multiple Event Code Screens
· Providers — Maintain Non-Licensed Providers

Figure 175: Event Capture Management Main Menu
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4.4.1 Location — Update Location Information 
The Location option allows Management users to create or remove access to an Event Capture 
location and flag it as active or inactive for use in the Event Capture software. When creating a 
location, the selection can be an individual facility or a division if the facility is multidivisional.
Before the User Starts

· Location selected must be in the INSTITUTION file (#4). 
· Locations must be created with this option before the user can establish DSS Units. No 

further options are functional until the user creates an Event Capture location. 

What the User Will See
· A list of existing locations displays in a grid format (Figure 176).
· For each location listed, the following information is displayed (if available): Name, 

State, Facility Type, Station Number, IEN, and whether this location is current. 
o The Name column contains the Location Name.
o The Station Number corresponds to the first part (the characters before the dash) of 

the feeder location when there is no division suffix.
o The IEN column contains the IEN of the INSTITUTION file (#4). The IEN 

corresponds to the first part (the characters before the dash) of the feeder location 
when there is a division suffix.

· A search field is available at the top of the screen, allowing the user to search for a 
specific location. 

Figure 176: Management Menu [Locations] Screen
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From the Locations screen, the user can select a location by double-clicking on a row or by 
highlighting a row and then clicking the Update button. After selecting a location, an edit screen 
appears, allowing the user to either create the location as a current Event Capture location or to 
remove the selected location (Figure 177).

Figure 177: Edit Location Screen

The rows within the Locations screen can be sorted by using the Sort menu (Figure 178) or by 
clicking on the column header. The default sort order will group locations based on whether they 
are current and lists the current locations group first. In addition, the default sort order lists the 
locations alphabetically within those groups.

Figure 178: Sort Location Menu Options

To create a current location, click the checkbox labeled “Create as current Event Capture 
location” and click the OK button (Figure 179). The location is “flagged” as active for use in the 
Event Capture software.

Figure 179: Creating a Current Location
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To remove a current location, click the checkbox labeled “Remove as current Event Capture 
location” and click the OK button (Figure 180). The location is “flagged” as inactive for use in 
the Event Capture software.

Figure 180: Removing a Current Location

Click the Export button to export the Locations listing to Excel. The tab in Excel is titled “ECS 
Location Table Export” (Figure 181).

Figure 181: Export — ECS Location Table

4.4.2 DSS Units  
This option allows you to add, edit, activate or inactivate DSS Units for use with Event Capture. 
Additionally, DSS Units without workload may be deleted. DSS Units typically represent the 
smallest identifiable work unit in a clinical service at the medical center and are defined by the 
VA Medical Centers (VAMCs).
A DSS Unit can represent any of the following:

· An entire service 
· A section of a service 
· A small section within a section 
· A medical equipment item used in patient procedures 
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Before the User Starts
· Use the Location — Update Location Information option to create an Event Capture 

location before using this option. 
· A prompt displays a notification to enter an Associated Stop Code only if the send “All 

Records” to PCE is set to NO. 
· No further options are functional until DSS Units are created. 

What the User Will See
· A list of DSS Units displays in table format.  

The rows within the DSS Units table can be sorted by using the Sort drop-down menu 
(Figure 182) or by clicking on any column header. The default sort order will arrange 
DSS Unit Names alphabetically. 

Figure 182: Sort DSS Units Menu Items

· A search field is available at the top of the screen, allowing the user to search for a 
specific DSS Unit. Options to search by “Active” or “Inactive” status are also available. 
Type in a partial search string, then click the binoculars button (Search) or hit <Enter>, 
to show entries meeting the search criteria. 

· The screen contains the following columns: 
o DSS Unit Name
o Unit IEN (becomes the end of the feeder location) — corresponds to the locally 

created Event Capture DSS Unit Name
o Active —  Status for DSS Unit (Yes or No)
o PCE — Reflects if workload is set to pass to PCE. Values include:

· All — Send all records
· OOS — Send Occasion Of Service records
· No — Send no records

o DSS Dept
o Service
o Medical Specialty
o Cost Center
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Figure 183: Management Menu [DSS Units] Screen

The Print button enables users to print the report.
The Export button enables users to export the data to an Excel spreadsheet (Figure 184).
Click the Update button to update an existing DSS Unit or click the Add button to add a new 
one. The Edit a DSS Unit or Add a DSS Unit screen will appear.

Figure 184: Export — DSS Units Table

Table 2 lists the element name and description for each field that appears on the Add or Edit DSS 
Unit screen:

Table 2: Element Name and Description

Element Name Description
DSS Unit Name The name of the DSS Unit being created
DSS Dept. and DSS 
Unit IEN

The value used to identify the DSS Department to which the DSS Unit is 
associated (1 to 14 characters).

The same DSS Department can be used for more than one DSS Unit
The DSS Unit IEN is a unique number assigned by the server, and is not 
editable in this screen

Service The service associated with this DSS Unit — from the SERVICE/SECTION file 
(#49)

Medical Specialty The medical specialty associated with this DSS Unit — from the MEDICAL 
SPECIALTY file (#723)

Cost Center The cost center associated with this DSS Unit — from the COST CENTER file 
(#420.1). Cost centers are defined in MP4-Part V, Appendix B of the Fiscal 
Service cost manuals.

DSS Unit Status Active — Lists Active Event Code Screens
Inactive — Lists Inactive Event Code Screens
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Element Name Description
Event Code Screens Inactivate — When an active DSS Unit is changed to inactive, all Event Code 

Screens within the DSS Unit are also inactivated.
Reactivate — When an inactive DSS Unit is changed to active, its Event Code 
Screens can either be reactivated or remain inactive.

Default Date / Time Now — The current date and time will populate during data entry
None — No default date and time will be populated during data entry. The user 
is required to enter the date and time of the patient procedure.

Allow Category Use Yes — Use categories to group procedures during data entry
No — Do not use categories to group procedures during data entry

Allow Duplicate 
Override

Yes — Spreadsheet data for this DSS Unit can have duplicates overridden and 
uploaded
No — Spreadsheet data for this DSS Unit will not allow duplicates to be 
overridden and uploaded

Send to PCE Defines the method used to send the user’s data to PCE for the DSS Unit 
being created.
All Records — Send All Records
No Records — Send No Records
Occasion Of Service — For Occasion Of Service workload that is sent to PCE

Associated Stop 
Code

This option will only appear when “No Records” or “Occasion Of Service” is 
selected for Send to PCE. Select the Stop Code associated with this DSS Unit. 
Be sure to select an active Stop Code.

Credit Stop Code This option will only appear when “No Records” is selected for Send to PCE, 
and an Associated Stop Code has been selected. Select the Credit Stop Code 
associated with this DSS Unit.

CHAR4 Code This option will only appear when “No Records” is selected for Send to PCE, 
and an Associated Stop Code has been selected. Select the CHAR4 Code 
associated with this DSS Unit.

Note:

· On both Add DSS Unit and Edit DSS Unit screens, the DSS Unit Status defaults to 
Active, and the Allow Category Use field defaults to No, but the user can select 
Yes.

· The default value for Allow Duplicate Override is No.
· When the Send to PCE option is set to No Records or Occasion Of Service, the 

Associated Stop Code field is enabled. 
· When the Send to PCE option is set to All Records, the Associated Stop Code field 

will not be visible. All other default options can be changed.
· The user can search for the Associated Stop Code by either description or code. The 

Associated Stop Code will display and will include both the description and the 
code.
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4.4.2.1 Delete a DSS Unit 
The Edit drop-down menu at the top of the DSS Units window (Figure 185) allows the user to 
delete an unused DSS Unit. If the user selects Delete the selected DSS Unit from the drop-down 
menu, the following prompt is displayed: "The selected DSS Unit will be deleted. Continue?". If 
"Yes" is selected, the system will check for any workload on the DSS Unit and its associated 
Event Code Screens. 

· If there is workload on the selected DSS Unit, then the DSS Unit will not be deleted. 
· If there is no workload on the selected DSS Unit, then the DSS Unit and its associated 

Event Code Screens will be deleted. 

Figure 185: Edit DSS Units Menu

Note:

· The VA MailMan service will send an automated message to the user listing the 
DSS Unit that has been deleted. An example of this message can be seen in 
Appendix C. 
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4.4.2.2 Add a DSS Unit 
The Add a DSS Unit function allows the user to create a new DSS Unit within ECS.
Step 1. Click the Add button. 

· The Add a DSS Unit Screen will display (Figure 186).

Figure 186: Add a DSS Unit Screen

Step 2. Enter a DSS Unit Name.
Step 3. Enter a DSS Dept.
Step 4. Select a Service from the list provided.
Step 5. Select a Medical Specialty from the list provided.
Step 6. Select a Cost Center from the list provided.
Step 7. Select the DSS Unit Status to Active or Inactive.
Step 8. Choose the Default Date / Time.
Step 9. Choose whether to Allow Category Use.

· A site may choose to use Categories to group procedures when entering data. Allowing 
category use does not mean Categories are required, but merely gives the site the option 
to use Categories. Setting this flag to "No" will not allow the site to use Categories when 
creating an Event Code Screen. 

Step 10. Choose whether to Allow Duplicate Override.
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Step 11. Choose the appropriate Send to PCE option: All Records, No Records, or Occasion Of 
Service.

Note

· When the Send to PCE option is set to All Records, the Associated Stop Code field 
will not be visible.

· When the Send to PCE option is set to No Records or Occasion Of Service, the 
Associated Stop Code field will be visible.

· Credit Stop Code and CHAR4 Code fields will be visible when an Associated Stop 
Code is selected. 

Step 12. When the Send to PCE selection is set to No Records, then (Figure 187): 

· An Associated Stop Code is required to be entered for the DSS Unit during setup.  
· A Credit Stop Code may be added.  
· A CHAR4 Code may be added. 

Step 13. When the Send to PCE selection is set to Occasion Of Service, then: 

· An Associated Stop Code is required to be entered for the DSS Unit during setup. 

Step 14. Assign access to the DSS Unit.
Step 15. Click the OK button when selections are complete.

Figure 187: Add a DSS Unit — Send to PCE with No Records



Event Capture System 2.0
User Guide 150 May 2025          

4.4.2.3 Update a DSS Unit 
The Update DSS Unit option allows the user to edit DSS Units for use with Event Capture.
Step 1. Select a DSS Unit from the list of DSS Units on the Management Menu [DSS Unit] screen.
Step 2. Click the Update button.

· The Edit DSS Unit screen will display for the selected DSS Unit (Figure 188)

Figure 188: Edit DSS Unit Screen

Step 3. Enter a DSS Unit Name.
Step 4. Enter a DSS Dept.
Step 5. Select a Service from the list provided.
Step 6. Select a Medical Specialty from the list provided.
Step 7. Select a Cost Center from the list provided.
Step 8. Select a DSS Unit Status value of Active or Inactive

· When changing the status of the DSS Unit from Inactive to Active: 
o Select the “Active” radio button under DSS Unit Status. 
o An Event Code Screens group-box is displayed containing radio buttons and a grid. 

(Figure 189). The radio buttons are labeled “Reactivate” and “Remain Inactive”. 
o To reactivate all the associated Event Code Screens, select “Reactivate”.
o To leave all associated Event Code Screens inactive, select “Remain Inactive”.
o Click OK to apply the change and file the record.
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Note: 

· If “Reactivate” is not selected, the Event Code Screens will remain inactive. 

· When changing the status of the DSS Unit from Active to Inactive: 
o Select the “Inactive” radio button under the DSS Unit Status. 
o Click OK to apply the change and file the record.

Note: 

· When the DSS Unit Status is changed from “Active” to “Inactive”, the associated 
Event Code Screens are automatically inactivated. 

Figure 189: DSS Unit Status Change from Inactive to Active

Step 9. Choose the Default Date / Time.
Step 10. Choose whether to Allow Category Use.

· If the DSS Unit is not used in any Event Code Screens, the "Allow Category Use" value 
can be toggled between "Yes" and "No". Once Event Code Screens using the DSS Unit 
have been defined, the user may change the "Allow Category Use" setting from "Yes" to 
"No" to disallow the use of Categories; however, if the "Allow Category Use" is set to 
"No", the radio buttons will be disabled, and the value cannot be changed. 

· Allowing Category use does not mean Categories are required, but merely gives the site 
the option to use Categories. Setting this flag to "No" will not allow the site to use 
categories when creating an Event Code Screen. 

Step 11. Choose whether to Allow Duplicate Override.
Step 12. Choose the appropriate Send to PCE option: All Records or No Records

Note:

· When updating an established DSS Unit, Send to PCE cannot be set to Occasion Of 
Service. Occasion Of Service can only be selected on initial DSS Unit setup. In 
addition, for an established DSS Unit with a Send to PCE set to Occasion Of 
Service, Send to PCE cannot be modified. 

· When the Send to PCE option is set to All Records, the Associated Stop Code field will 
not be visible. 



Event Capture System 2.0
User Guide 152 May 2025          

· When the Send to PCE selection is set to No Records, then (Figure 190):
o An Associated Stop Code must be entered for the DSS Unit during setup. 
o A Credit Stop Code may be added. 
o A CHAR4 Code may be added.

Figure 190: Update a DSS Unit — Send to PCE with No Records

Step 13. Click the OK button when selections are complete. 

4.4.2.4 To Grant Access to a DSS Unit 
From the Add or Update DSS Units screens, the user has the option to give specific users access 
to the DSS Unit being added or edited. 
Step 1.  Click the Access button at the bottom of the Add or Edit DSS Unit screen. 

· The Grant Access to DSS Unit Screen opens and has Include and Exclude fields (Figure 
191).

Step 2. Type the starting characters of the last name in the upper portion of the Excluded list 
box, or simply scroll through the list to search for a last name. 

· The Excluded list box contains the names of all active VistA users at the site. 

Step 3. Grant access to a specific DSS unit by moving a user to the Included list box. 

· Highlight a name in the Excluded list box and click the Include button or simply double-
click the name in the Excluded list box. 

· Access is denied by moving a user to the Excluded list box, either by highlighting a name 
in the Included list box and clicking the Exclude button, or by simply double-clicking the 
name in the Included list box. 

Step 4. Click the Apply button to save the changes and continue granting access to additional 
users or click the OK button to save the changes and return to the previous screen. 

Note:   

· The IEN and Person Class/Classification for a selected user appear below the 
associated Excluded or Included list box. 
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Figure 191: Grant Access to DSS Unit

4.4.2.5 To Disable Categories for a DSS Unit 
Step 1.  Select a DSS Unit which allows categories from the list of DSS Units and click the Update 

button. 

· The Edit DSS Unit screen opens for the selected DSS Unit (Figure 192).

Figure 192: Edit DSS Unit Screen Showing a DSS Unit Set to Allow Categories
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Step 2. In the Allow Category Use section (Figure 193), click the No radio button, then click the 
OK button. 

Figure 193: Allow Category Use Set to No

· A warning pop up window appears stating that if categories are disabled, this setting 
cannot be re-instated (Figure 194).

Step 3. Click Yes to confirm. 

Figure 194: Disable Category Warning Pop Up Message 

 

· On the Edit DSS Unit screen, the Event Code Screens section shows “None” listed in the 
Category column. The Allow Category Use section is now disabled (Figure 195).

Figure 195: Edit DSS Unit Screen After Disabling Categories
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Step 4. Click OK to return to the Management Menu [DSS Units] screen. 

Note: 

· Once categories are disabled for a DSS Unit, any fields for entering category 
information for that DSS Unit will be disabled on all Event Capture screens.

· Once categories are disabled for a DSS Unit, any previously entered workload will 
remain available for viewing and editing.

· A report is available to Management users which lists all DSS Units that do not 
allow use of categories. (See Section 4.3.2.2, Disabled Category and Procedure 
Summary).

· Event Code Screens without categories will remain available for use.

4.4.3 Access by User — Grant Access to DSS Units by User 
Before the User Starts

· Use extreme caution when using this option. Removing access to a specified DSS Unit 
for all users and inactivating the DSS Unit is not recommended without the permission of 
the associated service. 

· Contact each service for a list of its Event Capture users and the DSS Units for which 
they enter data. 

· The user must have access to a given DSS Unit before procedure data can be entered. 
· Access can be provided to all DSS Units by assigning the ECALLU security key to a 

specified user (normally the DSS Manager or designee) using the Allocation of Security 
Keys option in the Key Management Menu under the Menu Management Menu. 

Note: 

· This option cannot be used to remove access to DSS Units for users who hold the 
ECALLU security key. 

What the User Will See
· A list of users available for selection (Figure 196).
· For a selected user, the Available DSS Units and the Selected DSS Units display. 

Selected DSS Units represent the DSS Units for which the selected user has access 
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4.4.3.1 Assign User Access to DSS Units 
Step 1.  Select a user. 

Figure 196: Grant Access to DSS Units by User 

 

Step 2. Select one or more DSS Unit(s) in the Available list by highlighting the selected unit(s) 
and clicking on the Include button (Figure 197). 

· Press and hold the <Ctrl> key to select more than one DSS Unit. 
· Move highlighted items to the Selected list by clicking the Include button.  
· Similarly, access to DSS Units can be removed for the selected user by highlighting a 

DSS Unit in the Selected list, then clicking the Exclude button. 

Figure 197: Grant Access to DSS Units by User — Adding DSS Units

  

Step 3. Click the Apply button to apply the changes and continue working or click the OK button 
to apply the changes and exit the screen. 
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4.4.4 Category — Add or Update Categories 
This option allows Management users to enter or edit, but not delete, local categories in the 
EVENT CAPTURE CATEGORY file (#726).
DSS Units can be defined to use categories to group procedures during data entry. Categories are 
facility-specific; therefore, users can use names that best suit their facility. For example, for a 
DSS Unit named “Audiology and Speech,” categories could be named “Speech Evaluation” and 
“Audiology Testing.” It is acceptable to have both DSS Units that do use categories and DSS 
Units that do not use categories defined at a facility.
Before the User Starts

· The user can ignore this option if the site’s DSS Units are defined for use without 
categories. 

· Categories cannot be deleted, but this option can be used to inactivate or reactivate them. 

What the User Will See
· After selecting Category — Add or Update Categories from the Management Menu, the 

first window displays a list of Category Names, the Date created, and the Inactivation 
Date (Figure 198).

· The Management Menu [Categories] screen provides options to Add or Update a 
category. 

Figure 198: Categories Main Screen on Management Menu
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4.4.4.1 Add Categories 
Step 1.  Click the Add button, or use the menu bar, and select Edit > Add. 

· The Add Category screen opens (Figure 199).
· The Status field defaults to “Active.” 

Step 2. Enter the name of the category to be added and click the OK button. 

Figure 199: Add Category Screen 

 

4.4.4.2 Update Categories 
Step 1.  On the Management Menu [Categories] screen, select a category to modify and click 

Update. 

· The Update Category screen displays (Figure 200).

Step 2. Change the category to its new status by clicking Active or Inactive.
Step 3. Click the OK button to file the change and return to the previous screen.

· The Management Menu [Categories] screen will reflect the changes made. If the category 
was inactivated, the Inactivation Date will display the current date. 

 

Figure 200: Update Category Screen



Event Capture System 2.0
User Guide 159 May 2025          

The Export button enables users to export the data to an Excel spreadsheet (Figure 201).

Figure 201: Export — ECS Category Table

4.4.5 Procedure — Add or Update Local Procedures 
The Procedure option allows the user to enter or edit, but not delete local procedures in the EC 
National Procedure file (#725).
Before the User Starts

· Before using this option, print the National/Local Procedure Report from the Reports 
menu of the Event Capture Main Menu to print a list of procedures with their associated 
CPT codes. This report can be lengthy if it includes national procedures. This should be 
queued to print to a device during non-peak hours. 

· Enter an associated CPT code to pass local procedures to the PCE software. 
· A local procedure code number is required for any new local procedure. 
· The local number code must be five characters in length, starting with an uppercase alpha 

character, followed by four alphabetic or numeric characters. This number will be used as 
the national code number for the new local procedure. 

· With functionality put in place by the Code Set Versioning project, only active CPT 
codes are made available, and are based on the date a local procedure is added. 

What the User Will See
· After selecting Procedure — Add or Update Local Procedures from the Management 

Menu, the first screen displays a list consisting of Procedure Name, Number, CPT Code 
and Description, and Active status (Figure 202).

· The Procedure screen allows the user to select and display only Active or Inactive 
procedures via check-boxes on the upper left side of the screen.  

· The Procedures screen allows the user to Add or Update a procedure via buttons on the 
lower right side of the screen. 
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Figure 202: Management Menu [Procedures] Screen

4.4.5.1 Add Procedures 
Step 1.  Click the Add button, or use the menu bar, and select Edit > Add. 

· The Add Local Procedure screen opens (Figure 203).

Figure 203: Add Local Procedure

Step 2. Enter the new local Procedure Name.
Step 3. Enter the local Procedure Number.
Step 4. Enter the CPT Code if the data will transmit to the PCE software.

· The CPT Code and Description field contains CPT Code look-up functionality. The user 
can search for an existing CPT Code by code, a portion of the code, or a part of the 
description. 

Step 5. Select the Status (Active or Inactive). 

· The Status field defaults to “Active.” 

Step 6. Click the OK button. The new local procedure has been added. 
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· When attempting to file a new Local Procedure, the system compares the new procedure 
to the National Procedure code file to prevent duplication. If there is a conflict, a message 
is displayed, and the local procedure is not added. 

4.4.5.2 Update Procedures 
Step 1.  Highlight the existing record and click the Update button or double-click the row. 

· The Edit Local Procedure screen opens (Figure 204).

Figure 204: Edit Local Procedure

Step 2. Edit the Procedure Name, Procedure Number, CPT Code and Description, and/or Status. 

· Local procedures cannot be deleted, but the Status can be used to inactivate or reactivate 
them. 

· The CPT code for a local procedure can be deleted by deleting the value in the CPT Code 
and Description field, then clicking the OK button. 

Step 3. Click the OK button. 
· The updated local procedure appears on the Procedures screen. The highlighted row in 

Figure 205 shows the updated Procedure Name.

Figure 205: Update After Editing a Local Procedure
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The Procedures listing can be exported to Excel. The tab in Excel is titled “ECS Procedure Table 
Export” (Figure 206).

Figure 206: Export — Procedures

4.4.6 Reason — Add or Update Procedure Reasons 
Reasons are site-defined descriptions explaining why a procedure was performed for a patient.
Before the User Starts

· Users with the ECMGR security key can activate or inactivate existing reasons. 
· If a reason is listed as inactive, it will not appear on the dropdown list for reasons on any 

screen. 
· Event Capture managers can add a new reason using the Event Capture — New Reason 

screen. 
· New reasons will immediately be available for use in data entry. 

What the User Will See
· After selecting Reason — Add or Update Procedure Reasons from the Management 

Menu, the first screen displays a list of Active Reasons and Inactive Reasons (Figure 
207).

Figure 207: Management Menu [Reasons] Screen
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4.4.6.1 Activate Reasons 
Step 1.  Highlight one or more items from the Inactive Reasons list box and click the Activate 

button. 

· To move more than one reason, press and hold the <Ctrl> key and then highlight 
additional items (Figure 208).

Figure 208: Reasons Screen with Inactive Reasons Selected

The Inactive Reason(s) selected will appear in the Active Reasons column when the Activate 
button is clicked (Figure 209).

Figure 209: Reasons Screen with Inactive Reasons Moved to the Active Column

Click the Apply button to apply the changes and continue working or click the OK button to 
apply the changes and exit the screen. A confirmation prompt will appear. Click the Yes button 
to save the changes (Figure 210).

Figure 210: Confirmation Prompt
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4.4.6.2 Inactivate Reasons 
Step 1.  Highlight item(s) from the Active Reasons list box and click the Inactivate button. 

· To move more than one reason, click and hold the <Ctrl> key and then highlight 
additional items (Figure 211).

Figure 211: Reasons Screen with Active Reasons Highlighted

The Active Reason(s) selected will appear in the Inactive Reasons column when the Inactivate 
button is clicked (Figure 212).

Figure 212: Reasons Screen with Active Reasons Moved to the Inactive Column

Click the Apply button to apply the changes and continue working or click the OK button to 
apply the changes and exit the screen. A confirmation prompt will appear (Figure 213). Click the 
Yes button to save the changes.

Figure 213: Confirmation Prompt
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4.4.6.3 Add a New Reason 
Step 1.  Click the Add button. 

· The Event Capture — New Reason screen will appear (Figure 214).

Figure 214: New Reason Screen

Step 2. Type the name of the new reason, then click the OK button to add the reason to the 
Active Reasons column. Click the Cancel button to exit the screen without saving the record. 

· Once the new reason is added, it will appear on the Reasons screen (Figure 215).

Figure 215: Reasons Screen with New Reason Added

4.4.7 Event Code Screens  
This option allows you to add, edit, or copy Event Code Screens for use with Event Capture. 
Additionally, Event Code Screens without workload may be deleted.
The Event Code Screen option allows the user to create Event Code Screens for one or all Event 
Capture locations. Event Code Screens define procedure information. During data entry users 
can select only the procedures defined in the Event Code Screens. For each screen, you are 
prompted to enter the following information:

· DSS Unit  
· Category (If DSS Units are defined to group procedures by categories)  
· Procedure  
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Before the User Starts
· Use the Location — Update Location Information option to create an Event Capture 

location before using this option. 
· Use the DSS Unit — Add or Update DSS Units option to establish DSS Units before 

using this option. 
· Event Code Screens must be defined before entering any Event Capture data. 
· A prompt for Category occurs only if the Event Code Screen uses categories to group 

procedures. 
· The user must define an active Associated Clinic and CPT code to pass Event Code 

procedures to PCE. 
· With functionality put in place by the Code Set Versioning project, only active CPT 

codes can be selected, and they will be based on the date the Event Code Screen is being 
set up. 

· The Event Code Screen enables the use of characters “/” and “-” in the search field. 
· The Associated Clinic on the Event Code Screen is not auto-populated. 
· The Print and Export buttons are available on the Event Code Screen. 
· Users with the ECMGR key will be able to copy EC screens to another DSS Unit. 

What the User Will See
· After selecting Event Code Screen — Add or Update Event Code Screens from the 

Management Menu, the first screen displays a drop-down box of DSS Units. 
· Select a DSS Unit to display the Event Code Screen data. Options to search by “Active” 

or “Inactive” status are also available. Columns include Synonym, Procedure, Location, 
Default Associated Clinic, Category and Status (Figure 216).

Figure 216: Event Code Screens Example
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· Click the Print button to print the Event Code Screens listing. When printing the report, 
the user will be prompted to choose Active, Inactive or All for the Clinic Status (Figure 
217).

Figure 217: Select Clinic Status for the Event Code Screens Listing

· The Event Code Screens information can also be exported to Excel. The user will be 
prompted to choose Active, Inactive or All for the Clinic Status. The tab in Excel is titled 
“Event Code Table Export” (Figure 218).

Figure 218: Exported Event Code Table Report

4.4.7.1 Delete Event Code Screens 
The Edit drop-down menu at the top of the Event Code Screens window (Figure 219) allows the 
user to delete an unused Event Code Screen. If the user selects Delete the selected Event Code 
Screen from the drop-down menu, the following prompt is displayed: "The selected Event Code 
Screen will be deleted. Continue?". If "Yes" is selected, the system will check for any workload 
on the Event Code Screen.  

· If there is workload on the selected Event Code Screen, then the Event Code Screen will 
not be deleted. 

· If there is no workload on the selected Event Code Screen, then the Event Code Screen 
will be deleted. 
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Figure 219: Management Menu [Event Code Screens]

Note:

· The VA MailMan service will send an automated message to the user listing the 
Event Code Screens that have been deleted. An example of this message can be 
seen in Appendix C. 

4.4.7.2 Add Event Code Screens 
Step 1.  Select a DSS Unit from the dropdown list (Figure 220).
Step 2. Click the Add button or use the menu bar and select Edit > Add.

· The Add Event Code Screen will open (Figure 221).

Figure 220 Management Menu [Event Code Screens] Select DSS Unit
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Figure 221: Add Event Code Screen

Step 3. Make selections in the corresponding fields: Category (if enabled), Location 
(one/multiple/all), Procedure, Status (active/inactive), Procedure Synonym, Default Volume, 
Ask Reasons and Default Associated Clinic. 

Note 

· A clinic must exist in file #728.44 Clinics and Stop Codes prior to being available 
for selection in any Data Entry options.

· If an Associated Clinic has non-conforming stop codes, the clinic will not be 
selectable.

Step 4. Click the Add button to file the record and add another procedure, if desired (Figure 221). 
Select a procedure from the Procedure dropdown list. Repeat. 

Step 5. Click the OK button to file the record and return to the Event Code Screen list.

· The Add Event Code Screen closes, and the newly added Event Code Screen(s) are 
displayed in the list (Figure 222).
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Figure 222: Event Code Screen Added

Note: 

· If the user selects an inactive Associated Clinic and then clicks OK, an error 
message appears (Figure 223). Click OK on the error message to close it and return 
to the Add Event Code Screen. From there, the user can select an active Associated 
Clinic.

Figure 223: Add Event Code Screen — Record Not Filed Error

4.4.7.3 Update Event Code Screens 
Step 1.  Select a DSS Unit from the dropdown list.
Step 2. Highlight a procedure, then click the Update button or use the menu bar and select  

Edit > Update.

· The Update Event Code (EC) Screen form opens and displays the following fields: DSS 
Unit, Category, Location, Procedure, Status, Procedure Synonym, Default Volume, Ask 
Reasons, and Default Associated Clinic (Figure 224).
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Figure 224: Update Event Code Screen Example

Note:  

· If the user attempts to update an Event Code Screen that has an inactive Associated 
Clinic, an error message appears (Figure 225). The user has the option to select an 
appropriate active clinic or to leave the Associated Clinic blank.

Figure 225: Update EC Screen Error — Invalid Associated Clinic

Step 3. On the Update Event Code Screen, update the Procedure Synonym, Default Volume, 
Status, Ask Reason and/or Default Associated Clinic field values as desired (Figure 226). 

· The Default Associated Clinic list box displays only active locations in the HOSPITAL 
LOCATION file (#44) whose type is “C” (clinic) and is a “count” clinic. 

Note
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· A clinic must exist in file #728.44 Clinics and Stop Codes prior to being available 
for selection in any Data Entry options.

· If an Associated Clinic has non-conforming stop codes, the clinic will not be 
selectable.

Figure 226: Update Event Code Screen — Select Default Associated Clinic

Step 4. Click the OK button. 

· The changes for the Event Code Screen record are filed. The Update Event Code Screen 
closes, and the updated Event Code Screen is displayed in the list. 

4.4.7.4 Copy All Event Code Screens to Another DSS Unit 
Step 1.  Highlight an Event Code Screen that has an Active status (Figure 227). 

Figure 227: Event Code Screen with Active Status Selected
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Step 2. From the menu bar, select Edit > Copy all EC Screens to another DSS Unit (Figure 228). 

Figure 228: Edit > Copy all EC Screens to another DSS Unit

· The Select a target screen appears (Figure 229).

Figure 229: Select a Target Screen

Step 3. Select a target DSS Unit (usually newly created) from the dropdown list, and then click 
the OK button. 

Note: 

· The target DSS Unit is usually newly created by the user, but an existing DSS Unit 
may also be used.

· The Copy Event Code Screen to [user-selected target DSS Unit] window will open. 
See Figure 230 for an example.
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Figure 230: Copy Event Code Screen to DSS Unit

· The Location, Status, Procedure Synonym, Default Volume, Ask Reasons and Default 
Associated Clinic fields can be modified on this screen. 

· The DSS Unit and Procedure cannot be edited. 

Note: 

· If the DSS Unit is set up to not send records to PCE, the Default Associated Clinic 
is disabled. 

Step 4. Review the field selections and make edits (if necessary).
Step 5. Click the OK button to save the changes and create the copy.

· The next Event Code (EC) Screen window will appear. 
· To skip an Event Code Screen, click the Skip this EC Screen button. The next Event 

Code Screen window will appear. 

Step 6. When all needed Event Code Screens are copied, select the Close button to return to the 
Event Code Screen. 

· All the previous changes will be saved. 
· One, many or all Event Code Screens can be copied. 

Note: 

· If the user does not select a Location when copying an Event Code Screen, the 
record will not be filed, and two error messages will appear (Figure 231).

· Click the OK button on each error dialog to return to the Copy Event Code Screens 
form and enter a Location.
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Figure 231: Record Not Filed Error Message for Key Data Missing

4.4.7.5 Copy the Selected Event Code Screen to Other DSS Unit(s) 
Step 1.  Highlight an Event Code Screen that has an Active status (Figure 232). 

Figure 232: Event Code Screen with Active Status Selected

Step 2. From the menu bar, select Edit > Copy the selected EC Screen to other DSS Unit(s) 
(Figure 233). 

Figure 233: Edit > Copy the selected EC Screens to other DSS Unit(s)
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· The Select one or more targets screen appears (Figure 234).

Figure 234: Select One or More Target DSS Units

Step 3. Select one or more target DSS Units from the list, and then click the OK button. 

Note: 

· The target DSS Unit is usually newly created by the user, but an existing DSS Unit 
may also be used.

· Multiple DSS Units may be selected by holding down the <Ctrl> key while mouse 
clicking on the desired DSS Units.

The Copy Event Code Screen to [user-selected target DSS Unit] windows open (Figure 235) one 
at a time for each target DSS Unit selected in step 2, Figure 234. Follow steps 4 and 5 for each 
selection.

Figure 235: Copy Event Code Screen to DSS Unit
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Step 4. Review the field selections and make edits (if necessary). 

· The Location, Status, Procedure Synonym, Default Volume, Ask Reasons and Default 
Associated Clinic fields can be modified on this screen. 

· The DSS Unit and Procedure cannot be edited. 
· If the DSS Unit is setup to not send records to PCE, the Default Associated Clinic is 

disabled. 
Step 5. Click the OK, Add, or Skip this EC Screen button: 

· Click OK to save the changes and open the next Copy Event Code Screen to [user-
selected target DSS Unit] window (Figure 235).  

· Click Add to save the changes. To proceed to the next Copy Event Code Screen to [user-
selected target DSS Unit] window, click the Skip this EC Screen button.  

· Click Skip this EC Screen to bypass copying the Event Code Screen for the selected 
DSS Unit and to open the next selection.  

· When the Event Code Screen is copied to all selected DSS Units, the last window will 
close. All changes will be saved. 

Note:  

· If a Location is not selected when copying an Event Code Screen, the record will 
not be filed, and a message dialog will be displayed (Figure 236). Click the OK 
button on the message dialog to return to the Copy Event Code Screen form to enter 
a Location.

Figure 236: Required Data Missing
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4.4.8 Inactivate EC Screen — Identify Inactive Multiple Event Code 
Screens 

The Inactivate EC Screen option allows the user to identify active Event Code (EC) Screens that 
use a selected EC product code.
Before the User Starts

· Users with the ECMGR security key can select an EC Product Code (CPT Code, 
National EC Procedure Code or Local EC Procedure Code) and then display all the DSS 
Units using the selected Product Code on the Inactivate Selected Event Code (EC) 
Screens for Given Procedure Code form. 

· Choose to inactivate Event Code Screens by using the checkboxes in front of each entry. 
· The user can display and print a list of Event Code Screens inactivated for a chosen EC 

Product Code. 

What the User Will See
· After clicking the Inactivate EC Screen button on the Management Menu, the Event 

Capture — Inactivate Selected Event Code (EC) Screens for Given Procedure Code form 
will be displayed (Figure 237).

Figure 237: Inactivate Selected Event Code (EC) Screens for Given Procedure Code
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4.4.8.1 Inactivate Event Code Screen(s) 
Step 1.  Enter an Event Capture Product Code (CPT Code, National EC Procedure Code, or Local 

EC Procedure Code) in the search field and click the Search button. 

· All currently active Event Capture Product Codes are available for selection. 
· The associated DSS Units with IENs, Locations and Categories appear for the EC 

Product Code selected (Figure 238).

Figure 238: Inactivate Selected Event Code (EC) Screens with CPT Code Selected

Step 2. Use the checkboxes on the left side of the screen to select entries to be inactivated. 
· The user can select multiple checkboxes (Figure 238).

Step 3. Click the Apply button to apply the changes and continue working or click the OK button 
to apply the changes and exit the screen. 

· A confirmation prompt will appear. Click the Yes button to continue inactivating the 
selections. Click No to return to the previous screen (Figure 239).

Figure 239: Confirmation Prompt
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· When the user clicks Apply, a list of inactivated Event Code Screens is displayed (Figure 
240).

· Click the Print button to print the list of inactivated EC screens. 

Figure 240: List of EC Screens That Were Inactivated

Step 4. Click the OK button. 
· The changes are applied, and the user is returned to the Management Menu. 

Step 5. To verify that the Event Code Screens are inactivated, use the Inactivate Event Code 
Screens option, and reenter the Event Capture Product Code that was previously used. 

· The list of DSS Units, Locations and Categories does not include the inactivated Event 
Code Screens. 
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4.4.9 Providers — Maintain Non-Licensed Providers 
This option allows the Package Manager user to create a list of Non-Licensed Providers (i.e., 
staff without a Person Class). Workload for non-licensed providers can be entered for DSS Units 
that do not send records to PCE.
Before the User Starts

· For DSS Units that do not send to PCE, both Non-Licensed Providers (without a Person 
Class) and Providers (with a Person Class) may be selected as providers when entering 
workload.

· For DSS Units that send records to PCE (including Occasion Of Service DSS Units), 
staff without a Person Class may not be selected as a provider. 

What the User Will See
· After clicking the Providers button on the Management Menu, the Non-Licensed 

Provider Maintenance screen will be displayed (Figure 241).

Figure 241: Non-Licensed Provider Maintenance Screen
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4.4.9.1 Add a Non-Licensed Provider 
Step 1.  Highlight a staff member name in the Excluded list box, then click the Include button 

(Figure 242).
Step 2. Click OK to accept the changes.

Figure 242: Adding a Non-Licensed Provider

· Once a staff member has been added to the Included list as a non-licensed provider for 
any DSS Unit that does not send to PCE, this staff member will be selectable as a 
provider when entering workload (Figure 243).

Figure 243: Non-Licensed Provider Selection for DSS Units that Do Not Send to PCE
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4.4.9.2 Remove a Non-Licensed Provider 
Step 1.  Highlight a staff member name in the Included list box, then click the Exclude button 

(Figure 244).
Step 2. Click OK to accept the changes.

Figure 244: Removing a Non-Licensed Provider

· Once a staff member has been added to the Excluded list and removed as a non-licensed 
provider, the staff member will no longer be selectable as a provider when entering 
workload for DSS Units that do not send to PCE. 
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5 Troubleshooting 
The following subsections present some typical problems experienced by end users and the 
corresponding resolutions.

5.1 Access Issues 
Users need an Access Code and Verify Code obtained from their local OIT staff to use the Event 
Capture GUI.

5.2 Log-On Issues 
Event Capture is usually accessed through a desktop shortcut which points to the installation 
location. Ask the local support staff for assistance.
If Event Capture launches and then disappears or is not responding, make sure the IP address 
listed is correct and not blocked by firewall software for the system with which it is 
communicating. Local support staff is available to assist with issues.

5.3 GUI Appears Distorted 
If the ECS GUI display appears to be missing scrollbars, columns, or rows, ensure that the screen 
resolution is set to a resolution of 1440 x 900, or greater. Settings available will be dependent 
upon the user’s monitor size.

5.3.1 Example of Setting the Screen Resolution to 1920 x1080 
Step 1. Right-click anywhere on the computer’s desktop to open the Desktop Context Menu 

(Figure 245).  
Step 2. Select Display settings from the menu to open the window shown in Figure 246.

Figure 245: Desktop Context Menu — Display Settings
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Figure 246: Windows Display Resolution Settings

Step 3. Scroll down to view Scale and Layout settings. 
Step 4. Select 1920 x 1080 from the Display Resolution dropdown menu.

Note:  

· Depending on the user's version of Windows, this may look different. 
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Appendix A Acronyms and Abbreviations 
Table 3 lists the acronyms and abbreviations used throughout the ECS User Guide.

Table 3: Acronyms and Abbreviations

Acronym Description
2FA Two-Factor Authentication
AC Application Coordinator
ADPAC Automated Data Processing Application Coordinator
CCOW Clinical Context Object Workgroup
CHAR4 A 4-character code
CM Clinical Modification
CPRS Computerized Patient Record System
CPT Current Procedural Terminology
DSS Decision Support System
Dx Diagnosis
EC Event Capture, also Event Code
ECACCESS Security Key — Event Capture Access
ECALLU Security Key — Event Capture All DSS Units
ECMGR Security Key — Event Capture Manager
ECNORPT Security Key — Event Capture No Reports
ECPATIENT Event Capture Patient
ECPROVIDER Event Capture Provider
ECS Event Capture System
ECSPSH Security Key — Event Capture Spreadsheet
FY Fiscal Year
GUI Graphical User Interface
ICD International Classification of Diseases
ID Identification
IEN Internal Entry Number
IPC Inactive Person Class 
MAS Medical Administration Service
MCA Managerial Cost Accounting
MCAO Managerial Cost Accounting Office
NPCD National Patient Care Database
OIT Office of Information and Technology
PCE Patient Care Encounter
PIMS Patient Information Management System
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Acronym Description
PIV Personal Identification Verification
SC Service Connected
SSN Social Security Number
SSO Single Sign-on
T&TC Section 508 Accessibility Testing and Training Center
VA Veterans Affairs
VAMC Veterans Affairs Medical Center
VDL VA Software Document Library
VHA Veterans Health Administration
VistA Veterans Health Information Systems and Technology Architecture



Event Capture System 2.0
User Guide B-1 May 2025          

Appendix B Glossary 
Table 4 lists some of the terms used throughout the ECS FY24 User Guide. 

Table 4: Glossary of Terms 

Term Description
Associated Clinic The Associated Clinic of the Event Capture (EC) Procedure. CLINIC IEN is 

retrieved from the ASSOCIATED CLINIC field (#26) of the EVENT 
CAPTURE PATIENT file (#721).

Associated Stop Code The Stop Code that most closely represents the DSS Unit workload.
Category Category provides Event Capture a common level to group associated 

procedures. Multiple procedures can be defined for each category.
CCOW In the context of health informatics, CCOW is a Health Level 7 international 

standard protocol designed to enable disparate applications to synchronize 
in real time, and at the user interface level.

CHAR4 Code A 4-character code value of the associated clinic as specified from the DSS 
Clinics and Stop Code Worksheet File.

Combat Veteran Identifies if patient served in a combat zone. Veteran must have served in 
active duty in a theatre of combat operations during a period of war after the 
Persian Gulf War or in combat against a hostile force during a period of 
hostilities after November 11, 1998.

Computerized Patient 
Record System 
(CPRS)

Parameters are set up/maintained by the facility’s CPRS Coordinator/Clinical 
Application Coordinator (CAC).

Cost Center Cost Center reveals which service is using this DSS Unit.
Credit Stop Code The Credit Stop Code (from the HOSPITAL LOCATION file [#44]) as 

determined by Medical Administration Service (MAS). This is a DSS Identifier 
assigned to a clinic and may be utilized in several ways. We can use it to 
identify different provider types (NP, PA, Psychologist, etc.) and for various 
program groups (Care Coordination, Telemedicine, etc.), or to give additional 
credit to a second service in a joint clinic. 
DSS further uses credit stop codes to create unique feeder keys to identify 
clinic intermediate products. Examples are: 123 — Nutrition Individual, 124 
— Nutrition Group, 372 — MOVE! Individual, 373 — MOVE! Group.

Current Procedural 
Terminology (CPT) 
code

CPT codes are published by the American Medical Association. The purpose 
of the coding system is to provide uniform language that accurately 
describes medical, surgical, and diagnostic services.

Current Procedural 
Terminology (CPT) 
Modifier

CPT modifiers provide the ability to refine CPT procedure codes to better 
reflect procedures performed.

DSS Unit A DSS (Decision Support System) Unit defines the lowest level segment 
used for tracking hospital resources. These units can be a small work unit 
within a service or a large division within a service. Management at each 
facility is responsible for tailoring the DSS Units to fit its resource/cost 
reporting.

DSS Unit Number This code is used for additional identification of DSS Units.
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Event Capture Software designed to provide management tools necessary in tracking 
procedures not entered in other VistA packages.

Event Code Screen Event Code Screens are unique combinations of location, DSS Unit, 
category, and procedure that define patient procedures.

Graphical User 
Interface (GUI)

A type of display format that enables users to choose commands, initiate 
programs, and other options by selecting pictorial representations (icons) via 
a mouse or a keyboard.

ICD-10-CM International Classification of Diseases, Tenth Revision, Clinical Modification 
codes (based on the World Health Organization codes).

Internal Entry Number 
(IEN)

The number used to identify an entry within a file. Every record has a unique 
internal entry number.

Ionizing Radiation (ION 
RAD)

Exposure to ionizing radiation.

Location Initializing the user site as a location, the Event Capture software recognizes 
the user facility as a valid location to enter Event Capture data.

Medical Administration 
Service (MAS)

Now Patient Information Management System (PIMS).

Ordering Section The medical section ordering the patient’s procedure.
Patient Care Encounter 
(PCE)

The VistA Outpatient Encounters System. PCE builds a single encounter for 
each recorded instance of a patient receiving services within a clinic. PCE is 
the mechanism for the transmission of all encounter data to the National 
Patient Care Database (NPCD).

For outpatient encounters, DSS combines all instances with the same SSN, 
Date, and Primary Stop code into one outpatient encounter. However, on 
DSS, each of the clinic encounters of PCE appears as a resource utilization 
unit under the one encounter. This means that in DSS, a single outpatient 
encounter will be built by two or more records when they have a common 
encounter number.

The PCE column reflects if workload is set to pass to PCE. Values include:
All — Send all records
OOS — Send Occasion Of Service records
No — Send no records.

Patient Information 
Management System 
(PIMS)

The Scheduling module of the PIMS Package provides for efficient and 
accurate collection, maintenance and output of data that allows VA Medical 
Centers to provide timely and quality care to its patients.

Procedure A specific function performed on, or service provided to, a patient. Multiple 
procedures can be associated with a single category.

Procedure Reason A method of generically grouping patient procedures to further describe the 
event, often giving patient or provider information.

Procedure Synonym See Synonym
Provider The provider of care performing the procedure. This provider can be a 

doctor, nurse, technician, or any designated team of medical professionals.
Reason See Procedure Reason
Security Key Security Keys set a layer of protection on the range of computing capabilities 

available with a particular software application. The availability of options is 
based on the level of system access granted to each user.
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Service Connection The service connection (SC) box on the Enter/Edit Patient Data screen in 
ECS must be answered if it displays as a required option for that patient. 
Adjudicated service connection means that the facts, shown by evidence, 
establish that a particular injury or disease resulting in disability was incurred 
coincident with service in the Armed Forces, or if preexisting such service, 
was aggravated therein.

Southwest Asia 
Conditions

Patient encounter is related to exposure to Southwest Asia conditions while 
serving in the Southwest Asia Theater of operations.

Station Number A Station Number uniquely identifies every VA primary facility and division; 
however, entries for some facility types do not have Station Numbers. Station 
Numbers are stored in Field #99 in the VistA M Server INSTITUTION file 
(#4).

Stop Code A three-digit number that is used in VHA to identify the services that a patient 
receives at a Department of Veterans Affairs (VA) medical facility. Stop 
codes are also used to capture workload statistics. A stop code could either 
be classified as a primary or secondary stop code, (which is referenced as 
credit stop code). The Stop Code (from the HOSPITAL LOCATION file [#44]) 
as determined by Medical Administration Service (MAS).

Synonym A locally recognized name or description for a procedure. In VistA, this is a 
field in the OPTION file (#19). Options may be selected by their menu text or 
synonym.

T&TC Section 508 Accessibility Testing and Training Center.
Unit IEN The internal entry number (IEN) for this record. The number to identify this 

DSS unit locally at the user’s site (1 to 14 characters). The same DSS Unit 
number can be used for more than one DSS Unit.

Verify Code A secret password used along with the Access Code to provide secure user 
access to the VistA M Server. It is used by Kernel's Sign-on/Security system 
along with the Access code to validate the user's identity.

VistA Veterans Health Information Systems and Technology Architecture (VistA) is 
the proprietary software developed for and used by the VA VHA to support 
its clinical and administrative functions at VA sites nationwide. It is both 
client- and server-based software. The client-based software is written in 
Java, Borland Delphi Pascal, and other GUI-based languages and runs on 
the Microsoft operating system. The server-based software is written in the M 
programming language and, via Kernel, runs on all major M implementations 
regardless of the vendor. It is composed of integrated clinical, infrastructure, 
and financial/administrative software applications. This internally developed 
portfolio of applications is recognized as the most comprehensive integrated 
health information system in the United States.

Volume Volume is usually associated with the number of procedures performed. This 
field can also be used to track number of bed days, or to track time 
increments spent performing the procedure. For example, if “15-minute 
increment” is the unit, volume of 1 = 15 minutes, volume of 2 = 30 minutes, 
etc.
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Appendix C ECS Package Administrative Messages 
Set up an ECS mail group in VistA to receive relevant ECS notifications. Contact IT to set up a 
VistA ECS Mail Group so more than one person receives ECS administrative messages.
Examples of ECS package administrative email messages included in this section:

· When a new ECS patch is released
· When a patch updating the National Procedure Codes is released
· When Event Code Screens are inactivated due to changes in National Procedure Codes
· When terminated users result in access to DSS Units being affected
· When a DSS Unit with no workload is deleted
· When an Event Code Screen with no workload is deleted

When a new ECS patch is released
Figure 247 is a screen capture of an example of the email message a user could receive when an 
ECS patch is released.

Figure 247: Example Email Message when an ECS Patch is Released
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When a patch updating the National Procedure Codes is released
Figure 248 is an example of the email message a user could receive when a patch that updates 
National Procedure Codes is released.

Figure 248: Example Email Message for Updated National Procedure Codes Patch

When EC Screens are inactivated due to changes in National Procedure Codes
When an EC NATIONAL PROCEDURES file (#725) patch is loaded, a review of the EVENT 
CODE SCREENS file (#720.3) is performed. Event Code Screens, which have either inactive 
CPT or procedure codes, or a procedure code with an inactive “default” CPT code attached, are 
reported.
Figure 249 is a screen capture of an example of the message a user could receive stating that 
Event Code Screens should be reviewed due to changes in the EC NATIONAL PROCEDURES 
file (#725).
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Note:
After a patch updating file #725:
· Check for Inactivated National Procedure Codes.
· Check for Event Code Screens with out-of-date procedure codes.

Figure 249: Example of Event Code Screens to Review Message
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When terminated users result in access to DSS Units being affected
Figure 250 is a screen capture of an example of the email message a user could receive when an 
ECS User is terminated.

Figure 250: Example 1 — ECS User Terminated Email Message

Figure 251 is a screen capture of another example of the email message a user could receive 
when an ECS User is terminated.

Figure 251: Example 2 — ECS User Terminated Email Message
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When a DSS Unit with no workload is deleted
Figure 252 shows an example of the automated MailMan message that arrives with the subject 
“DELETION OF UNUSED DSS UNIT FROM FILE #724”. The accompanying message lists 
the deleted DSS Unit.

Figure 252: Example Message when a DSS Unit is Deleted

When an Event Code Screen with no workload is deleted
Figure 253 shows an example of the automated MailMan message that arrives with the subject 
“DELETION OF UNUSED EVENT CODE SCREENS FROM File #720.3”. The accompanying 
message lists the deleted Event Code Screen(s).

Figure 253: Example Message when Event Code Screens are Deleted
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